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EMPLOYABILITY SKILLS

CHAPTER 1: Communication Skills–II
Unsolved Questions
 Ans 1. Communication forms the foundation of a society, facilitating the exchange of 

information, ideas and emotions. This sharing of information allows individuals 
to understand each other and work collectively towards common goals.

  Effective communication facilitates the transfer of knowledge and understanding, 
allowing individuals to collaborate, make decisions and solve problems together. 
People use communication to convey their needs, share experiences, build 
relationships and convey emotions.

  Moreover, communication is crucial for the transmission of culture and knowledge 
from one generation to the next. Through spoken and written communication, older 
members of the society can pass down their experiences, wisdom, traditions and 
values. This passing on of knowledge helps maintain the identity and continuity 
of a society over time.

 Ans 2. 

Verbal Communication Written Communication
(i) Definition Involves spoken words to 

convey information, ideas and 
emotions.

Involves written or printed 
words to convey messages.

(ii) Dynamics Dynamic and immediate 
interaction.

S ta t i c  and  prov ides  a 
permanent record.

(iii) Modes Face-to-face conversations, 
phone calls, video calls, 
presentations, etc.

Emails, letters, reports, 
essays, social media posts, etc.

(iv) Feedback and 
Clarification

Allows real-time feedback and 
clarification.

Feedback is delayed and 
might not be immediate.

(v) Emotional 
Connection

Allows emotional connection. Lacks immediate emotional 
impact.

 Ans 3. Non-verbal communication refers to the transmission of messages and information 
through means other than words. It involves using various non-verbal cues such as 
facial expressions, gestures, body language, posture, eye contact, touch and vocal 
cues like pitch, tone and rhythm, in addition to proxemics (the use of space). These 
cues can convey emotions, attitudes, intentions and other information without the 
need for explicit verbal expression.
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  Some essential parts of non-verbal communication include:

Facial Expressions Our faces express how we feel. For example, when we smile, 
it usually means we’re happy or friendly. When we frown, 
it might mean we are sad or upset.

Gestures We use hand movements and gestures to express ourselves. 
For instance, waving “hello” is a friendly gesture. Thumbs 
up is a sign of approval while pointing can show you’re 
indicating something specific.

Eye Contact When we look someone in the eyes, it usually means we 
are paying attention to them. It shows we are interested 
in what they are saying. But if we avoid eye contact, it 
might mean we are shy or not very interested.

Body Language How we stand or sit can say a lot. For instance, if we 
stand up straight and look confident, it shows we are self-
assured. But if we slouch and look down, it might mean 
we are feeling unsure or sad.

Tone of Voice How we say something matters. If we say “thank you” with 
a happy and grateful tone, it sounds sincere. But if we say 
it with an annoyed tone, it might not be as genuine.

Distance How close or far we stand from someone can convey a 
message. If we stand really close, it might show we are 
comfortable with them. If we keep our distance, it might 
mean we want some space.

 Ans 4. Visual communication is a method of conveying information, ideas or messages 
through visual elements such as images, graphics, charts, diagrams and symbols, 
rather than through words or text. Visual communication can be highly effective 
because it appeals to our sense of sight, making complex information more 
understandable and engaging.

  Visual communication offers several important benefits over verbal and non-verbal 
communication as listed below.

 (i) Universally Understandable: Visuals can be understood across cultures and 
languages, making them universally accessible and eliminating language 
barriers.

 (ii) Engagement: Visuals capture attention and keep the audience engaged, 
enhancing message retention and understanding. They further help in reaching 
a wide audience.

 (iii) Immediate Comprehension: Visuals are processed quickly by the brain, allowing 
for rapid understanding of the intended message.

 (iv) Inclusivity: Visual communication includes individuals with varying levels of 
literacy making information accessible to a broader audience.

 (v) Memorability: People tend to remember visual information better than text, 
making it an effective way to convey important information that needs to be 
retained.

 (vi) Simplicity and Clarity: Visuals can simplify complex concepts or instructions, 
making them easier to comprehend and follow.

 (vii) Safety and Emergency Situations: In situations where immediate action is 
required, visual symbols and signs can convey critical instructions swiftly, 
potentially preventing accidents or harm.



Book-X 3

 Ans 5. Feedback is the guiding compass in communication, pointing you in the right 
direction and helping you understand where you need to adjust. Feedback is 
important in communication for several reasons, as listed below:

 (i) Clarity and understanding
 (ii) Correcting mistakes
 (iii) Building relationships
 (iv) Encouraging communication
 (v) Understanding others
 (vi) Effective problem-solving

  Feedback Example 1:
  Consider a teacher explaining a new topic in class, like how the water cycle works. 

While teaching, the teacher might realise some students have not understood the 
topic properly. He might say, “Does anyone have any questions or want this part 
to be explained again?”

  This is a way for the teacher to get feedback from the students. If a few students 
raise their hands and say they are confused, it helps the teacher understand that 
particular topic needs to be explained in a different manner. So, feedback helps 
the teacher know if their teaching is clear and if students are able to understand 
the lesson properly.

  Feedback example 2:
  Consider a teacher giving feedback on a student’s presentation. The teacher might 

say, “Your content was good, but you can improve your speaking skills.” This helps 
the student understand how they should prepare their presentations and improve 
upon the skills they are currently lacking.

 Ans 6. Communication barrier is an obstacle that gets in the way of effective communication 
between two or more persons. It makes it difficult for information and thoughts 
to be understood by both parties. Communication barriers can take various forms, 
such as language differences, misunderstandings and confusions.

  Given below are the types of communication barriers and their examples:
 (i) Internal Barriers
  Example: Yash, a student, has been asked to share his thoughts in class, but 

he gets really nervous and his mind goes blank. This feeling of nervousness 
is an internal barrier. It is like a mental wall that can make it tough to 
speak up, even though he knows what he wants to say. To overcome this, it 
is best to take a deep breath, practise the speech and remind yourself that 
it is okay to make mistakes—to err is human!

 (ii) External Barriers
  Example: When a classroom is located near a busy road, the noise from the 

traffic outside makes it difficult for students to hear and concentrate on the 
teacher’s lecture.

 Ans 7. The role of feedback in overcoming communication barriers is:
 (i) Understanding: It helps the receiver understand what they did right and 

what they need to work on, without any confusion.
 (ii) Motivation: It encourages them because it shows they are doing well in some 

areas and gives tips to improve in others.
 (iii) Focused Improvement: It tells the receiver exactly where to focus their efforts 

to get better.
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 (iv) Two-way Talk: The receiver can ask questions and have a real conversation 
about the feedback.

 (v) Continuous Learning: It helps the receiver keep learning and getting better 
over time.

 (vi) Better Results: By following the advice, they can get better results in their 
work.

  Example 1: If a teacher gives descriptive feedback on a student’s assignment, 
they might say, “Your introduction and first two paragraphs are great! But for a 
stronger ending, summarize your main points and give a clear final thought. Keep 
it up!” This helps the student know exactly what to do to improve their writing.

  Example 2: If a teacher gives constructive feedback on a student’s drawing, they 
might say, “You used bright colors nicely, but try making your lines straighter for 
neater edges.” This helps the student realize his area of improvement.

 Ans 8. The communication cycle is a model that helps us understand how communication 
works between individuals or groups. Any exchange of ideas between two or more 
people can be characterized with the help of a back-and-forth process, which allows 
the exchange to proceed gradually. This back-and-forth exchange is known as the 
communication cycle.

  Each communication cycle has some essential elements which contribute to the 
overall process of effective communication:

 (i) Sender: The cycle begins with the sender—the person who initiates the 
communication by encoding a message. Encoding means putting thoughts 
and ideas into words or symbols that convey meaning.

 (ii) Message: The sender formulates a message, which contains the information 
or ideas they want to communicate.

 (iii) Channel: The message is transmitted through a communication channel, which 
could be verbal (speaking, writing) or non-verbal (gestures, body language).

 (iv) Receiver: The message reaches the receiver—the person or group for whom 
the message is intended. The receiver decodes the message, interpreting the 
words or symbols to understand the intended meaning.

 (v) Feedback: After understanding the message, the receiver provides feedback 
to the sender. Feedback is a crucial part of the communication cycle as it 
helps the sender know if the message was understood as intended.

 Ans 9. Sentences can be categorized into four basic types, based on their purpose and 
structure. These types are assertive/declarative, interrogative, imperative and 
exclamatory sentences.

 (i) Assertive/Declarative Sentences: Declarative sentences make statements or 
express facts, opinions or ideas. They typically end with a period (.) to indicate 
a complete thought. For example, She enjoys reading books.

 (ii) Interrogative Sentences: Interrogative sentences ask questions and seek 
information. They typically start with a question word (who, what, when, 
where, why, how) or an auxiliary verb and end with a question mark (?). For 
example, Where is the nearest library?

 (iii) Imperative Sentences: Imperative sentences give commands, instructions or 
make requests. They usually start with a verb (the base form) and can be 
either a direct command or a more polite request. For example, Close the 
door. (command) / Please pass me the salt. (request)
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 (iv) Exclamatory Sentences: Exclamatory sentences express strong emotions or 
excitement. They typically end with an exclamation mark (!) to emphasize 
the emotion. For example, What a beautiful sunset!

 Ans 10. In English, a phrase is a group of words that works together, but it doesn’t have 
both a subject and a verb. It is a small piece of sentence. The role and importance 
of phrases in constructing sentences are as follows:

 (i) They describe actions.
 (ii) They give additional information.
 (iii) They show relationships between words.

  Examples of Phrases:
 • Under the table (describes where)
 • Very slowly (describes how)
 • In the garden (describes where)

  On the other hand, a sentence is a complete thought or idea that contains a subject 
(who or what the sentence is about) and a verb (what the subject is doing). A 
sentence can stand alone and make sense by itself.

 Ans 11. Articles are words that are used to specify a noun as definite (the) or indefinite 
(a, an). They provide important information about the noun they precede.

 (i) Definite articles refer to specific or particular nouns and are represented by 
the word “the”. Use “the” when referring to a specific noun that is known to 
both the speaker and the listener or that has been previously mentioned in 
the conversation.

  For example, I saw the cat on the roof. Here, “the” is used because it is a 
particular cat that both the speaker and the listener know or have been 
discussing.

 (ii) Indefinite articles include the words “a” and “an”. They are used to refer to 
non-specific or unspecified nouns, indicating any member of a group.

 Ans 12. A paragraph is a distinct section of text that presents and discusses a single main 
idea or topic. It is a fundamental unit of writing and is composed of one or more 
sentences that revolve around a central point. Within a paragraph, there is a 
logical flow of related thoughts.

  Before writing a paragraph, several basic considerations should be taken into 
account to ensure clarity, coherence and effectiveness in communication.

 (i) Define the Topic or Main Idea: Clearly understand and define the main idea 
or topic that the paragraph will revolve around. This provides a clear direction 
for your writing.

 (ii) Consider the Audience: Think about the audience that will be reading the 
paragraph. Adapt the language, style and level of detail to suit their needs 
and understanding.

 (iii) Plan the Structure: Outline the structure of the paragraph, including the topic 
sentence, supporting sentences and a concluding or transition sentence.

 (iv) Organize Supporting Ideas: Arrange the supporting ideas or details in a logical 
order that strengthens the main point.

 (v) Ensure Cohesion and Flow: Use appropriate transitional words and phrases 
to ensure smooth transitions between sentences and ideas.

 (vi) Stay Focused and Relevant: Keep the paragraph focused on the main idea, 
avoiding irrelevant or off-topic information. Each sentence should contribute 
to the central point.



CHAPTER 2: Self-Management Skills–II
Unsolved Questions
 Ans 1. Stressors are events, situations or conditions that trigger stress responses in 

individuals. These stress-inducing factors can vary widely in nature and intensity, 
and are perceived as challenges or threats by the person experiencing them. 
Recognizing the specific stressors that affect an individual is a dire necessity for 
effective stress management.

  Identifying stress is important to address it effectively. Stress can present itself 
and affect a person in various ways. Thus, recognizing these signs is crucial. 
Stress may affect a person physically, mentally and emotionally. It may also cause 
changes in the behaviour of a person with others while interacting.

 Ans 2. Some commonly observed symptoms of stress are presented below:

  Physical Symptoms
 • Headaches or migraines
 • Muscle tension or body aches
 • Fatigue and low energy levels
 • Trouble sleeping or excessive sleep
 • Changes in appetite—eating too much or too little

  Emotional Symptoms
 • Feelings of anxiety or nervousness
 • Irritability or quick temper
 • Sadness, low mood or frequent crying
 • Difficulty concentrating or making decisions
 • Feeling overwhelmed or out of control
 • Difficulty in maintaining relationships
 • Increased conflicts with family, friends or peers

  Behavioural Symptoms
 • Changes in academic performance or motivation
 • Avoiding tasks or responsibilities
 • Increased use of substances like caffeine, alcohol or drugs
 • Withdrawal from social activities or isolating oneself

  Cognitive Symptoms
 • Racing thoughts or constant worrying
 • Forgetfulness or memory problems
 • Negative self-talk or pessimistic outlook

  Identifying stress is important to address it effectively and it also aids in stress 
management. If one notices these signs, it is important to take them seriously 
and seek professional help. Talking to a trusted friend or supporting adults like 
parents, teachers or school counsellors is recommended as a first step in managing 
stress effectively.

 Ans 3. Deep breathing involves taking slow, deep breaths. Inhale through your nose, hold 
for a few seconds and exhale slowly through the mouth. This relaxation technique 
helps in stress reduction by calming your mind and body. Managing stress is 
crucial for the overall well-being of humans.
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 Ans 4. Effective allocation of time and resources to accomplish tasks and goals while 
maintaining a balance between work, personal life and leisure forms a key aspect. 
The process of defining clear and achievable objectives, which provide direction 
and motivation for self-improvement, is imperative.

  This helps in the ability to make thoughtful and informed decisions that align 
with personal values and long-term objectives. Thus, effective time management 
ultimately contributes to stress management and achieving personal goals.

 Ans 5. The foundation of self-management, self-awareness is the ability to recognize and 
understand one’s emotions, strengths, weaknesses, values and goals.

  This skill involves managing and controlling one’s emotions in a healthy way, 
allowing for effective responses to challenging situations.

  It is essential to understand your strengths, weaknesses, values and beliefs. 
Knowing yourself well helps you make informed decisions that align with your true 
self. Self-management is essential for the personal development and well-being of 
human beings. It helps us in the following ways:

 (i) Enhanced Resilience: The ability to recover from setbacks and adapt to 
challenges is a key component of self-management.

 (ii) Stress Reduction: Self-management techniques help in managing and reducing 
stress, which is essential for both mental and physical health.

 Ans 6. Emotional Regulation involves managing and controlling one’s emotions in a healthy 
way, allowing for effective responses to challenging situations.

  It is the ability to recover from setbacks and adapting to challenges is a key 
component of self-management. It contributes to a sense of personal fulfilment 
and satisfaction as individuals align their actions with their values and passions, 
thus leading to better decision-making and reducing stress levels.

 Ans 7. Developing a growth mindset helps in learning and improvement. It is essential 
to understand your strengths, weaknesses, values and beliefs. Knowing yourself 
well helps you make informed decisions that align with your true self.

  Learn to negotiate and stand up for what you believe is right. It is always helpful 
to surround yourself with supportive and encouraging people who believe in you and 
your capabilities. Learn to bounce back from setbacks and keep going in the face 
of challenges. Resilience is a key trait for independence. Thus, a growth mindset 
helps an individual to approach challenges with a positive mindset and also aids 
in managing stress.

 Ans 8. Becoming independent is a gradual process that involves developing various skills 
and adopting certain attitudes. It involves taking responsibility for one’s actions, 
time and outcomes, demonstrating a high degree of autonomy and self-reliance.

  Embracing self-reliance and independence cultivates confidence and autonomy. 
Working independently encourages continuous learning and personal growth. You 
seek out information, acquire new skills and develop a deeper understanding of 
your strengths and weaknesses.

 Ans 9. The key traits that help one to become independent are:
 (i) Manage your Goals and Time: Clearly define your short-term and long-term 

goals. Understand what matters most to you and what you want to achieve. 
Learn to manage your time effectively by setting realistic goals, creating 
schedules and prioritizing tasks. Avoid procrastination and stay organized.
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 (ii) Take Responsibility: Acknowledge that you are in control of your choices and 
actions. Avoid blaming others for your circumstances and take responsibility 
for your decisions.

 (iii) Develop Self-Awareness: It is essential to understand your strengths, weaknesses, 
values and beliefs. Knowing yourself well helps you make informed decisions 
that align with your true self.

 (iv) Make your Own Decisions: Practice making decisions independently, starting 
with small choices and gradually tackling more significant ones. Consider the 
pros and cons before making a decision. Work on your critical thinking and 
problem-solving skills. Analyze situations, consider various solutions and take 
the time required in choosing the best ones.

 (v) Keep Learning: Be curious and eager to learn. Read books, take courses, 
attend workshops and seek knowledge in areas that interest you. Develop a 
growth mindset that embraces learning and improvement.

 (vi) Learn to Advocate for Yourself: Express your needs, opinions and desires 
assertively and respectfully. Learn to negotiate and stand up for what you 
believe is right. It is always helpful to surround yourself with supportive and 
encouraging people who believe in you and your capabilities. Learn to bounce 
back from setbacks and keep going in the face of challenges. Resilience is a 
key trait for independence.

 Ans 10. Positive self-talk involves challenging yourself to face adversities, keeping in mind 
the bright side of things. This further fosters a growth mindset, for there is no 
growth without challenges. Growth mindset realizes the importance of hard work 
and dedication. Thus, both positive self-talk and growth mindset further promotes 
foster self-reliance and resilience.



CHAPTER 3: ICT Skills–II
Unsolved Questions
 Ans 1. The role of an operating system in a computer is:
 (i) Managing Hardware: The operating system ensures that all parts inside the 

computer, like the keyboard, screen and memory, work together smoothly.
 (ii) Running Programs: OS helps us open and use software like games, word 

processors and web browsers.
 (iii) File Management: It organizes and stores our files and folders, making it 

easy to find and use them.
 (iv) Memory Management: OS decides which programs can use the computer’s 

memory (RAM) and how much of it they can use.
 (v) User Interface: OS provides an interface for us to interact with the computer 

via icons, buttons and windows.
 (vi) Security: It helps protect our computer from viruses and makes sure that 

only authorized users can access it.
 (vii) Networking: If we connect our computer to the internet, the OS manages the 

connection so that we can browse the web and send emails.

 Ans 2. Single-user operating systems are designed to support only a single user at a time. 
For example, MS-DOS. On the other hand, multi-user operating systems allow 
multiple users to use the computer simultaneously. It ensures user isolation and 
resource sharing. Unix/Linux systems are known for multi-user capabilities, where 
multiple people can log in and use the computer concurrently.

 Ans 3. Real-time Operating System (RTOS) is designed for systems where responses must 
be guaranteed within strict time constraints. It is common in embedded systems, 
robotics and industrial control.

  Real-time operating systems (RTOS) like FreeRTOS and QNX are used in devices 
like robots and medical equipment.

 Ans 4. The Recycle Bin is a virtual trash can for your computer. When you delete a 
file or folder, Windows does not immediately erase it. Instead, it sends it to the 
Recycle Bin. This provides a safety net in case you accidentally delete something 
important.

  You can access the Recycle Bin from your desktop or from File Explorer. Inside 
the Recycle Bin, you can view, restore or permanently delete the files that you 
have previously deleted. Restoring a file from the Recycle Bin returns it to its 
original location, while permanently deleting it removes the file from your computer 
entirely. It is a useful feature for file management and recovery.

 Ans 5. Copying and pasting files or folders is useful because it helps you keep a backup in 
case something goes wrong. Copying files might come in handy if you accidentally 
delete something.

  It also helps organize different folders, thus making them easy to find. In addition, 
you may share these copies with friends by sending them through email or putting 
them on a USB drive.

  There are three different methods to copy and paste files or folders in Windows: 
using keyboard shortcuts, using right-click context menu and using drag-and-drop 
method.



10 Essentials of Information Technology—Teacher’s Manual

 Ans 6. Temporary files are created by various applications and the operating system itself 
to store data temporarily or perform specific tasks. Temporary files may include 
cached web pages, log files, setup files and more. Temporary files can be regularly 
cleaned with a simple yet powerful tool in Windows called Disk Cleanup.

  These files serve specific purposes but can accumulate over time, consuming disk 
space unnecessarily. Thus, regularly clearing temporary files is important to clear 
space and remove unwanted files.

 Ans 7. A computer virus is a type of malicious software (malware) designed to replicate 
itself and spread from one computer to another. It can attach itself to installed 
programs or files. When these infected files are executed or opened, the virus 
activates, causing various harmful effects on the computer.

  Detecting the presence of a virus on your computer is difficult. However, you have 
to keep observing unusual or unexpected behaviour since it can be harmful to 
your computer system. Some common signs of a virus infection include a sudden 
decrease in system performance, frequent crashes or freezes, unexpected pop-up 
ads, unexplained changes to system settings or files and unusual network activity.

  Regularly scanning your computer with antivirus software and keeping your system 
updated can help you identify and address virus infections early.

 Ans 8. Firewalls are essential for computer security as they help prevent unauthorized 
access. They act as a filter, allowing only legitimate and safe network traffic to 
pass through while blocking malicious or suspicious activity. They are particularly 
valuable for safeguarding sensitive data, preventing malware infections and 
maintaining the confidentiality and integrity of network communications.

  Firewalls protect the system/network from hackers who take the help of viruses, 
phishing emails, spams and the like.

 Ans 9. Internet cookies, often simply referred to as “cookies”, are small pieces of data 
stored on your computer by the websites you visit. They are created by web servers 
to remember certain information about your interactions with the site, such as 
login credentials, site preferences and items in a shopping cart. Cookies typically 
store anonymous data or user preferences. They do not store sensitive personal 
information like Aadhaar numbers or credit card details.

  Cookies serve various useful purposes in enhancing your online experience. They 
do so by helping websites access and gain insights into user preferences. Moreover, 
they facilitate seamless navigation and personalized interactions.

 Ans 10. The components of Windows’ user interface and their respective functions are:
 (i) Desktop: The desktop is the primary screen that you see after logging into 

Windows. It serves as the main workspace where you can place icons, shortcuts 
and files. You can customize the desktop with wallpapers and arrange icons 
according to your preference.

 (ii) Icons and Shortcuts: Icons represent files, folders, applications or other items 
on your desktop. Shortcuts are icons that point to programs or files, making 
them easily accessible.

 (iii) Start Button: It is located on the lower-left corner of the desktop. Clicking the 
start button opens the Start Menu. The Start Menu in a Windows operating 
system acts as a host to essential elements for navigating and accessing 
various features and functions.
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  In most versions of Windows, the Start Menu houses the following buttons:
 • Search Box: The search box allows you to quickly search for files, applications, 

settings or even web content.
 • Power Button: The power button allows you to shut down, restart or put 

your computer to sleep.
 • User Account Picture/Name: This button displays the currently logged-in 

user’s account picture or name.
 (iv) Taskbar: The taskbar runs along the bottom of the screen, offering easy access 

to running applications, the Start button, system notifications and the system 
tray (where you can find system icons like volume control and Wi-Fi status).

 (v) Notification Area: Located on the right side of the taskbar, it displays icons 
for system notifications, such as updates, messages and alerts. You can also 
access quick settings like Wi-Fi and volume controls from here.

 (vi) Date/Time: Displayed in the notification area, it provides the current time 
and date.

 (vii) Recycle Bin: The Recycle Bin is a virtual trash can for your computer. When 
you delete a file or folder, Windows does not immediately erase it. Instead, it 
sends it to the Recycle Bin. This provides a safety net in case you accidentally 
delete something important.

 Ans 11. Microsoft Windows is undoubtedly one of the most popular operating systems today. 
The earlier versions of Windows offered a user-friendly Graphical User Interface 
(GUI) that made computers more accessible to users, as opposed to the prevalent 
command-line interfaces.

  Additionally, Microsoft’s strategic partnership with computer manufacturers came in 
handy, ensuring Windows came pre-installed on many PCs. This further expanded 
its reach. Besides, continued improvement made Microsoft Windows a familiar and 
dependable choice for personal and business computing.

  Key features and advantages of Windows OS are:
 (i) User-friendly interface and easy to use
 (ii) Compatible to all hardware
 (iii) Supports Plug and Play feature
 (iv) Provides software development support

 Ans 12. The Start button is located on the lower-left corner of the desktop. Clicking the 
start button opens the Start Menu. The Start Menu in a Windows operating system 
acts as a host to essential elements for navigating and accessing various features 
and functions. In most versions of Windows, the Start Menu houses the following 
buttons, which further aid in computer navigation:

 (i) Search Box: The search box allows you to quickly search for files, applications, 
settings or even web content. Simply type what you are looking for and 
Windows will provide relevant results.

 (ii) Power Button: The power button allows you to shut down, restart or put your 
computer to sleep.

 (iii) User Account Picture/Name: Displays the currently logged-in user’s account 
picture or name. Clicking on this button can provide quick access to user-related 
settings and options, such as signing out or changing your account settings.

 Ans 13. Proper maintenance extends the lifespan of devices in the same way human health 
requires maintenance. Preventive maintenance of computers and smartphones 
through regular updates, cleaning and optimizing their performance prevents 
technical issues and vulnerabilities. A well-maintained device operates efficiently. 
When devices run smoothly, they facilitate productivity as well.
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  The following are some examples of routine maintenance tasks:
 (i) Turn Off and Restart: Start your computer fresh by shutting it down at the 

end of the day and restarting it in the morning to refresh system resources.
 (ii) Check for Updates: Regularly check for and install operating system and 

software updates.
 (iii) Scan for Malware: Run a quick antivirus or anti-malware scan to ensure 

your system is free of threats.
 (iv) Clear Unnecessary Files: Delete temporary files, clear browser caches and 

empty the Recycle Bin to free up disk space and improve system performance.
 (v) Backup your Data: If you work with important files daily, make sure they 

are backed up either to an external drive or cloud storage to protect against 
data loss.

 (vi) Clean the Physical Computer: If you are using a desktop computer, dust off 
the exterior and clean the keyboard and screen when necessary.

 (vii) Password Management: Be mindful of strong password practices and consider 
using a password manager to keep your online accounts secure.

 (viii) Close Unnecessary Programs: Ensure that unnecessary programs or applications 
are closed to conserve system resources.

 (ix) Check Security Alerts: Keep an eye on security alerts or notifications from your 
antivirus software and operating system for any immediate actions required.

 Ans 14. An unmaintained computer may suffer from reduced performance, frequent crashes 
and hardware failure due to overheating or dust buildup. It is also vulnerable to a 
range of other threats. Over time, it accumulates digital clutter, outdated software 
and security weaknesses, making it an easy target for malware and cyberattacks. 
Viruses, spyware and ransomware can infiltrate and compromise an unattended 
system. This could potentially lead to data theft, loss or corruption.

  Regular maintenance helps reduce these risks by extending the lifespan of devices 
in the same way human health requires maintenance. Preventive maintenance 
of computers and smartphones through regular updates, cleaning and optimizing 
their performance prevents technical issues and vulnerabilities. A well-maintained 
device operates efficiently. When devices run smoothly, they facilitate productivity 
as well.

 Ans 15. Cleaning the external components of your computer, taking your keyboard, mouse, 
camera and storage media under the umbrella, is essential to maintain hygiene 
and functionality. The following are some cleaning tips for computers:

  Cleaning the computer monitor/screen:
 • Turn off the monitor before cleaning.
 • Use a microfibre cloth and screen cleaning solution to gently clean the screen. 

Avoid using paper, towels or rough materials that can scratch the screen.
 • Gently wipe the monitor screen in a straight, horizontal or vertical motion. Avoid 

applying excessive pressure.

  Cleaning the keyboard and mouse:
 • Turn off or unplug the keyboard or mouse before cleaning.
 • Use compressed air and a small brush to remove dust and debris from the 

keyboard and mouse.
 • Wipe down the surfaces with a damp, lint-free cloth to clean the keyboard and 

the mouse, including keys and buttons.



CHAPTER 4: Entrepreneurial Skills–II
Unsolved Questions
 Ans 1. The significance of entrepreneurship is:
 (i) Economic Growth: Entrepreneurship drives economic growth by creating new 

businesses, industries and jobs.
  Example: N.R. Narayana Murthy co-founded Infosys, one of India’s largest IT 

companies, which has contributed significantly to the growth of the IT sector 
in the country.

 (ii) Innovation: Entrepreneurs develop new products, services and technologies 
that enhance our quality of life, solve problems and drive progress in various 
fields.

  Example: Chetan Maini, the founder of Reva Electric Car Company, introduced 
electric vehicles to combat air pollution and reduce India’s reliance on fossil fuels.

 Ans 2. Some common myths associated with entrepreneurship are given below, along with 
why they can be misleading:

 (i) Entrepreneurs are born, not made: This myth suggests that entrepreneurship 
is an inborn trait. This can be misleading because while some natural skills 
may help, entrepreneurship can be learned and developed through education, 
experience and mentorship.

 (ii) You need a brilliant idea to start: Many believe they must come up with a 
ground-breaking, revolutionary idea to start a business. This is misleading 
because in reality, successful ventures often improve existing ideas or address 
common problems creatively.

 (iii) Only young people succeed: Entrepreneurship is not limited by age. This is 
misleading since successful entrepreneurs come from various age groups and 
backgrounds, and experience can be an advantage in certain industries.

 (iv) Entrepreneurs are all tech geniuses: Technology does play a significant 
role in some ventures. However, this is myth is misleading because not 
all entrepreneurs are tech experts. Many successful businesses operate in 
traditional industries.

 (v) Failure means the end: Failure is a part of the entrepreneurial journey. It 
doesn’t mean the end of your career but an opportunity to learn and pivot. 
Many successful entrepreneurs faced failures before achieving success.

 (vi) Entrepreneurship requires massive capital: People often think they need 
substantial capital to start a business. This is misleading because many 
successful businesses began with minimal funds.

 (vii) Success happens overnight: Entrepreneurship is often glamorized, making it 
seem like success happens quickly. However, in reality, most entrepreneurs 
face challenges and setbacks, navigating their way through them.

 (viii) It is a solo journey: Entrepreneurship doesn’t have to be a solitary endeavour. 
Successful entrepreneurs often collaborate with partners, teams, mentors and 
advisors to achieve their goals.

 (ix) It is all about money: While financial success is a goal for many entrepreneurs, 
it is not the only motivation. Entrepreneurs often start ventures to pursue 
their passions, make a positive impact or address a personal mission.

 (x) You must have extensive experience: While experience can be helpful, it is not 
a strict requirement. This myth can be misleading since entrepreneurship 
often thrives on fresh perspectives and innovative ideas from individuals with 
diverse backgrounds.
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 Ans 3. The following are some key qualities or skills that successful entrepreneurs possess:
 • Vision: Successful entrepreneurs have a clear vision of what they want to achieve. 

They can see opportunities and possibilities that others may miss.
 • Risk-taking: Entrepreneurs understand that not every venture will succeed but 

they are prepared to take risks, learn from failures and keep trying.
 • Problem-solving: Entrepreneurs are problem-solvers. They are resourceful and 

creative in finding ways to overcome obstacles.
 • Decisiveness: Entrepreneurs need to make important decisions quickly. They 

gather information, analyze it and then make confident decisions.
 • Leadership: As leaders of their ventures, entrepreneurs must inspire and motivate 

their teams. Effective leadership is essential for the success of a business.
 • Continuous Learning: Entrepreneurship is a journey of learning and growth. 

Successful entrepreneurs are curious and committed to continuous self-
improvement.

 Ans 4. The following are the roles that entrepreneurs often play in their ventures:
 (i) Innovator: Entrepreneurs often introduce new ideas, products or services to 

the market.
 (ii) Visionary: Entrepreneurs set the vision and long-term goals for their businesses.
 (iii) Marketer: Entrepreneurs create marketing strategies, develop branding and 

promote their products or services to reach a wider audience.
 (iv) Financial Manager: Entrepreneurs manage the financial aspects of their 

businesses. This includes budgeting, financial forecasting, securing funding 
and monitoring cash flow.

 (v) Adaptability: The business world is constantly changing. Successful 
entrepreneurs are adaptable and can change strategy in the face of unexpected 
challenges. Thus, being adaptable forms the most essential role of an 
entrepreneur.

 Ans 5. The various categories of entrepreneurs and their unique contributions are as follows:
 (ii) Social Entrepreneurs: Social entrepreneurs are driven by a strong desire to 

address pressing social or environmental issues while also creating sustainable 
business models. They prioritize positive societal impact over profit. Example: 
Arunachalam Muruganantham, known as the “Padman” of India, created low-
cost sanitary napkins for rural women, addressing menstrual hygiene issues 
and empowering women in rural areas.

 (ii) Women Entrepreneurs: Women entrepreneurs are those who start and manage 
businesses, contributing not only to economic growth but also challenging gender 
stereotypes and promoting gender equality. Example: Kiran Mazumdar-Shaw 
founded Biocon, a biotechnology company that focuses on affordable healthcare 
solutions. She is a prominent female entrepreneur who has broken barriers 
in a male-dominated industry.

 (iii) Environmental Entrepreneurs (Ecopreneurs): Ecopreneurs prioritize 
environmental sustainability in their businesses, working to reduce 
environmental impact. Example: Chetan Maini, the founder of Reva Electric 
Car Company, introduced electric vehicles to combat air pollution and reduce 
India’s reliance on fossil fuels.

 (iv) Tech Entrepreneurs: Tech entrepreneurs leverage technology to develop 
innovative solutions, products or services. They often contribute to economic 
growth and job creation by establishing tech startups. Example: N.R. Narayana 
Murthy co-founded Infosys, one of India’s largest IT companies, which has 
contributed significantly to the growth of the IT sector in the country.
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 (v) Rural Entrepreneurs: Rural entrepreneurs establish businesses in rural areas, 
creating employment opportunities and preventing migration to urban centres. 
They often work with local resources and traditional practices. Example: 
Chetna Gala Sinha founded Mann Deshi Bank, which supports rural women 
entrepreneurs in Maharashtra.

 (vi) Youth Entrepreneurs: Youth entrepreneurs are young individuals who start 
businesses at a relatively early age. They bring fresh perspectives, energy 
and creativity to entrepreneurship. Example: Ritesh Agarwal founded OYO 
Rooms, a tech-enabled budget accommodation platform, when he was just  
19 years old.

 Ans 6. Some significant impact of entrepreneurship on society include:
 (i) Job Creation: When entrepreneurs start businesses, they often need help to 

run them. This is where job opportunities come in. An entrepreneur is a job 
creator as they provide work to many people, giving them a chance to earn 
a living, thus reducing unemployment.

 (ii) Innovation: Entrepreneurs are problem-solvers. They come up with new ideas, 
inventions and services that can make life better. Innovation improves our 
quality of life and can even lead to exciting discoveries.

 (iii) Community Development: Entrepreneurs often care about community 
development. They support local causes, sponsor events or help schools and 
charities, giving back to society and making the community stronger.

 Ans 7. Although there are countless ways a society can benefit an entrepreneur, some 
key ones are listed below:

 (i) Infrastructure: Entrepreneurs rely on the infrastructure that society builds 
and maintains. This includes roads, transportation systems, communication 
networks and utilities.

 (ii) Financial Resources: Society often provides financial support to entrepreneurs 
through banks, investors, grants and subsidies.

 (iii) Market Opportunities: Society provides entrepreneurs with a customer base 
for their products or services. Without consumers and businesses willing to 
buy what entrepreneurs offer, their ventures wouldn’t succeed.

 (iv) Networking and Collaboration: Entrepreneurs often collaborate with others in 
society, including suppliers, partners and other businesses. These relationships 
can lead to innovation and growth opportunities.

 Ans 8. Society benefits entrepreneurs in many ways. Society provides entrepreneurs with 
a customer base for their products or services. It often provides financial support 
to entrepreneurs through banks, investors, grants and subsidies, etc. Moreover, 
entrepreneurs rely on the infrastructure that the society builds and maintains 
including roads, transportation system, etc.

  However, entrepreneurship is not a one-way traffic. While society benefits 
entrepreneurs, they also return the favour. They are the driving force that can 
bring about positive changes in society. They help in creating job opportunities, 
encourage and foster innovation, boost economic growth, support communities and 
inspire people to take action through social causes.

 Ans 9. Entrepreneurship is not a new phenomenon. Even before it was named so, 
entrepreneurship has always played a role in human history but its significance 
has evolved over time.

 • Ancient Times: Early entrepreneurs engaged in trade, agriculture and 
craftsmanship. They contributed to the growth of cities and civilizations through 
their economic activities.
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 • Industrial Revolution (18th-19th centuries): The Industrial Revolution marked a 
significant shift, with entrepreneurs leading innovations in manufacturing and 
technology. This period saw the rise of factories and modern industry.

 • 20th Century: The 20th century witnessed the emergence of entrepreneurship 
as a driver of economic growth. Innovations in transportation, communication 
and technology paved the way for new business opportunities.

 • 21st Century: In the digital age, entrepreneurship has gained unprecedented 
importance. Technology startups, social entrepreneurship and global connectivity 
have transformed the entrepreneurial landscape.

 Ans 10. Several myths and misconceptions about entrepreneurship can deter people 
from pursuing their venture ideas. It is essential to understand these myths, 
debunk them and also create awareness to encourage more individuals to explore 
entrepreneurship.

  Example: Many believe they must come up with a ground-breaking, revolutionary 
idea to start a business. However, believing in such myths can discourage potential 
entrepreneurs because in reality, successful ventures often improve existing ideas 
or address common problems creatively. For example, Mark Zuckerberg co-founded 
Facebook, which became a global phenomenon. While Facebook’s concept was 
innovative, it wasn’t entirely new. Social networking existed before Facebook but 
Zuckerberg executed the idea exceptionally well, emphasizing user experience and 
privacy, proving that execution matters as much as the idea.

 Ans 11. The following are some challenges faced by entrepreneurs:
 (i) Success cannot happen overnight: Entrepreneurship is often glamorized, making 

it seem like success happens quickly. However, in reality, most entrepreneurs 
face challenges and setbacks, navigating their way through them.

 (ii) Fear of failure: Failure is a part of the entrepreneurial journey. It doesn’t 
mean the end of your career but an opportunity to learn and pivot. Failure 
is an essential rung of the ladder that leads to success.

 (iii) Market competition: Market competition is a significant challenge faced by 
entrepreneurs. With many businesses being started, the business environment 
has become highly competitive.

  The challenges mentioned above can be overcome with resilience and adaptability. 
Resilience refers to the ability that entrepreneurs must possess to overcome 
challenges and setbacks. Resilience must be accompanied with patience and 
perseverance. Moreover, the business world is constantly changing. Thus, successful 
entrepreneurs are adaptable and can change strategy in the face of unexpected 
challenges.

 Ans 12. Thomas Edison faced numerous failures while inventing the light bulb. He famously 
said, “I have not failed. I’ve just found 10,000 ways that won’t work.” His persistence 
and ability to learn from failures eventually led to success.

  Colonel Sanders, the founder of Kentucky Fried Chicken (KFC), did not find 
success until later in life. He began franchising KFC at the age of 65, proving 
that entrepreneurship is not limited by age.

 Ans 13. The following are the benefits of choosing entrepreneurship as a career:
 (i) Independence and flexibility: Entrepreneurs have the freedom to be their 

bosses and make decisions independently. Entrepreneurs often have flexibility 
in terms of work hours and location.
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 (ii) Potential for financial reward and personal growth: While entrepreneurship 
involves risks, it also offers the potential for significant financial rewards. It 
can also lead to personal growth, resilience and increased self-confidence.

 (iii) Job creation and legacy building: Entrepreneurs contribute to the economy 
by creating jobs and employment opportunities for others, thereby making a 
positive impact on their communities. They can leave behind a business or 
innovation that continues to benefit society long after they have moved on.

 (iv) Passion, purpose and creativity: Most entrepreneurs are driven by a sense 
of purpose and passion for their ventures. They pursue what they love and 
believe in, which can lead to greater job satisfaction. Entrepreneurship also 
allows individuals to express their creativity and vision through their business 
ventures.

  The following are the drawbacks of choosing entrepreneurship as a career:
 (i) Risk and uncertainty: Entrepreneurship comes with its own set of risks. 

With the market overflowing with nascent businesses, it is apparent that 
entrepreneurship as a career is full of risks and uncertainties.

 (ii) Wavering income: Entrepreneurship can be rewarding but not always. The 
initial stages are full of stress, long hours of work and irregular income.



CHAPTER 5: Green Skills–II
Unsolved Questions
 Ans 1. Natural resources form the foundation of human sustainability. Nature has showered 

us with abundant gifts in the form of natural resources that are the building 
blocks of our existence. They encompass everything—from water, air and soil to 
minerals, forests and wildlife. These resources provide us with the essentials for 
survival, like food, water, shelter and energy. For centuries, humans have relied 
on these resources to meet their needs and build civilizations.

  Our dependence on natural resources has remained a question of survival since the 
early civilizations. With extreme exploitation of natural resources over centuries, 
humankind has reached a situation that is threatening our own existence. 
Unfortunately, climate change, resource scarcity and ecological imbalances have 
turned into stark realities.

 Ans 2. The term “sustainable development” gained widespread recognition following the 
publication of the Brundtland Report in 1987. Officially titled, “Report of the 
World Commission on Environment and Development,” it was named after its 
chair, Gro Harlem Brundtland. His report defines Sustainable Development as 
“the development that meets the needs of the present without compromising the 
ability of future generations to meet their own needs.”

  The significance of sustainable development in addressing global environment and 
social challenges lies in its three major objectives:

 (i) Economic Sustainability: This pillar focuses on continued economic growth 
and prosperity while ensuring that it is sustainable over the long term. We 
have come to recognize that economic development is essential for improving 
living standards, eradicating poverty and providing opportunities for all.

 (ii) Social Sustainability: This pillar focuses on improving the well-being and quality 
of life for all individuals within the society. It recognizes that sustainable 
development should prioritize the welfare of people by addressing their basic 
needs such as health, education and social inclusion.

 (iii) Environmental Sustainability: This pillar focuses on preserving and protecting 
the natural environment, including ecosystems, biodiversity and the climate. 
It recognizes that human well-being is intricately linked to a healthy planet 
and aims to ensure that development does not harm the environment.

 Ans 3. The three major objectives of sustainable development, also known as the “three 
pillars” or “triple bottom line” are:

 (i) Economic Sustainability: This pillar focuses on continued economic growth 
and prosperity while ensuring that it is sustainable over the long term. We 
have come to recognize that economic development is essential for improving 
living standards, eradicating poverty and providing opportunities for all.

  Economic sustainability emphasizes responsible resource management and 
promotion of equitable economic systems, with the reduction of inequality as 
explained:

 • Responsible Resource Management: Economic sustainability calls for the 
responsible use of natural resources, ensuring that resource extraction and 
consumption do not deplete or harm the environment beyond repair. This 
involves efficient resource utilization and minimizing waste.

 (ii) Social Sustainability: This pillar focuses on improving the well-being and quality 
of life for all individuals within the society. It recognizes that sustainable 
development should prioritize the welfare of people by addressing their basic 
needs such as health, education and social inclusion.
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 • Basic Needs: Social sustainability aims to ensure that everyone has access 
to basic necessities such as clean water, food, shelter and healthcare. It 
also includes paying heed to issues like sanitation and hygiene.

 • Health and Education: It promotes good health and quality education as 
fundamental rights. Ensuring access to healthcare and quality education 
eventually helps individuals lead productive and fulfilling lives.

 • Social Inclusion: Social sustainability emphasizes creating inclusive societies 
wherein all individuals, regardless of their background, ethnicity, gender 
or other factors have equal opportunities and rights.

 (iii) Environmental Sustainability: This pillar focuses on preserving and protecting 
the natural environment, including ecosystems, biodiversity and the climate. 
It recognizes that human well-being is intricately linked to a healthy planet 
and aims to ensure that development does not harm the environment.

 • Conservation of Ecosystems: Environmental sustainability involves conserving 
ecosystems, including forests, wetlands, oceans and other habitats. This 
helps maintain biodiversity and preserves the services these ecosystems 
provide, such as clean air and water.

 • Mitigation of Climate Change: It addresses the reduction of greenhouse 
gas emissions and the mitigation of climate change impacts. This includes 
transitioning to renewable energy sources and implementing strategies to 
adapt to changing climatic conditions.

 • Resource Efficiency: Environmental sustainability promotes resource 
efficiency and the reduction of pollution and waste. This involves sustainable 
agriculture, responsible consumption patterns and the adoption of eco-
friendly technologies.

 Ans 4. One stark example showcasing the best practices of sustainable process 
implementation in Indian airports is the Cochin International Airport Limited (CIAL) 
in Kochi, Kerala. CIAL has gained international recognition for its sustainability 
initiatives, particularly in the area of environmental conservation and energy 
management.

  Sustainable Practices at Cochin International Airport
  (i) Solar Power Generation: CIAL houses one of the largest solar power plants 

at an airport in the world. It covers vast areas of airport land with solar 
panels, generating a significant portion of its energy needs from solar power. 
This initiative aligns with SDG 7 (Affordable and Clean Energy) by reducing 
the airport’s carbon footprint and reliance on non-renewable energy sources.

  (ii) Waste Management: The airport has implemented efficient waste management 
practices, including waste segregation and recycling. Organic waste is converted 
into biogas, which is used for cooking and power generation. Such practices 
align with SDG 12 (Responsible Consumption and Production), aiming to 
reduce waste and promote sustainable resource use.

  (iii) Biodiversity Conservation: CIAL has undertaken initiatives to protect and 
enhance biodiversity on its premises. It has developed green zones, including 
a butterfly garden and a large area of mangrove forests. These efforts align 
with SDG 15 (Life on Land) by promoting the conservation and sustainable 
use of terrestrial and marine ecosystems.

  (iv) Water Conservation: The airport has left no stone unturned while implementing 
rainwater harvesting and water recycling systems. This helps in reducing water 
consumption and dependence on external water sources. These practices align 
with SDG 6 (Clean Water and Sanitation) by promoting efficient water use.
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  (v) Energy Efficiency: CIAL has adopted energy-efficient technologies and practices, 
including LED lighting and energy-efficient air conditioning systems. These 
measures contribute to SDG 7 (Affordable and Clean Energy) by reducing 
energy consumption and emissions.

 Ans 5. A green economy is an economic system that seeks to promote sustainable 
development by incorporating principles and practices that reduce environmental 
risks and ecological scarcities. It aims to enhance human well-being and social 
equity.

  The essential components of a green economy include:
  (i) Renewable Energy: The transition to renewable energy sources such as solar, 

wind, hydroelectric and geothermal power is the cornerstone of a green 
economy.

  (ii) Resource Efficiency: Resource efficiency involves using resources such as 
water, energy and materials more effectively to minimize waste and reduce 
environmental impact.

  (iii) Clean Technologies: The development and adoption of clean and eco-friendly 
technologies are crucial for reducing pollution and conserving resources.

  (iv) Sustainable Agriculture: A green economy promotes sustainable farming 
practices that minimize the use of harmful chemicals, conserve soil and water, 
and protect biodiversity.

  (v) Circular Economy: The Circular Economy model focuses on reducing, reusing 
and recycling products and materials to minimize waste and extend the life 
cycle of products. It creates a closed-loop system where no one is unfamiliar 
with reusing and recycling resources.

  (vi) Biodiversity Conservation: Protecting and preserving biodiversity is integral 
to a green economy. It safeguards ecosystems, wildlife and natural habitats 
to maintain ecological balance and ecosystem services.

 Ans 6. A green consumer, also known as an environmentally conscious or eco- conscious 
consumer, is an individual who makes purchasing decisions keeping in mind 
environmental and sustainability considerations. These consumers prioritize products 
and services that have a reduced impact on the environment and support sustainable 
practices. They play a significant role in driving demand for environmentally 
friendly products and services. Their choices can influence businesses to adopt more 
sustainable practices, leading to a more environmentally responsible economy.

 Ans 7. Green skills are a set of knowledge, abilities and competencies that enable 
individuals to work in industries that prioritize environmental sustainability and 
address environmental challenges. These skills are essential for promoting eco-
friendly practices, reducing environmental impact and supporting the transition 
to a greener and more sustainable economy. Green skills encompass a wide range 
of areas that describe their role in supporting eco-friendly professions:

  (i) Renewable Energy: Skills related to the design, installation, maintenance and 
management of renewable energy systems such as solar, wind and hydropower.

  (ii) Energy Efficiency: Abilities to improve energy efficiency in buildings, industrial 
processes and transportation systems, leading to reduced energy consumption 
and lower carbon emissions.

  (iii) Sustainable Agriculture: Knowledge of sustainable farming practices, organic 
farming techniques and agroecology to minimize the environmental impact 
of agriculture while ensuring food security.
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  (iv) Environmental Management: Competencies in environmental assessment, 
conservation and compliance with environmental regulations in various 
industries.

  (v) Green Building and Design: Skills in sustainable architecture and construction, 
including energy-efficient building design, use of eco-friendly materials and 
green building certifications.

  (vi) Waste Management: Expertise in waste reduction, recycling and waste-to-
energy technologies to minimize waste generation and promote recycling.

  (vii) Water Management: Knowledge of water conservation, wastewater treatment 
and sustainable water usage practices for industries and municipalities.

  (viii) Sustainable Transportation: Abilities to promote eco-friendly transportation 
options such as public transit, cycling, electric vehicles and the development 
of sustainable urban mobility solutions.

  (ix) Ecological Restoration: Competencies in ecosystem restoration and biodiversity 
conservation to rehabilitate and protect natural habitats.

  (x) Climate Change Mitigation and Adaptation: Knowledge and skills related 
to climate change science, adaptation strategies and emission reduction 
techniques.

  These skills can be developed through education and experience as knowledge 
instils the desire to protect and save the environment—not only for oneself but 
also for future generations.

 Ans 8. Ongoing professional development is crucial in the context of green skills and 
sustainability as it ensures professionals stay abreast of evolving practices, 
technologies, and regulations in environmentally-conscious fields. By continuously 
updating their knowledge and skills, individuals can effectively contribute to 
sustainable initiatives, such as renewable energy, waste reduction, and eco-friendly 
practices. Additionally, ongoing development fosters innovation, enabling professionals 
to devise creative solutions to complex environmental challenges. Ultimately, 
prioritizing professional growth in green skills promotes the long-term health of 
the planet and facilitates the transition towards a more sustainable future.

 Ans 9. The 4Rs and 1U are a set of principles that guide sustainable resource management 
and waste reduction. These are strategies that help in minimizing the environmental 
impact of unnecessary resource consumption and waste generation.

 • Reduce: The first principle of the 4Rs is reduce. It involves minimizing the 
consumption of resources by using them less or only whenever required.

 • Refuse: The second principle is refuse and it involves saying no to unnecessary 
or harmful products or practices that contribute to resource depletion or 
environmental degradation.

 • Reuse: The third principle is reuse, which emphasizes finding creative ways to 
use items multiple times instead of discarding them after a single use. Reusing 
can include repurposing old furniture, donating clothing or using refillable 
containers instead of disposable ones.

 • Recycle: The fourth principle is recycle and it focuses on collecting and processing 
recyclable materials like paper, glass, plastic and metals to create new products.

 • Upcycle: Upcycle is the innovative addition to the 4Rs, denoting the process 
of repurposing discarded or unused materials into products of higher value or 
quality than the original. It encourages creative thinking and transforms waste 
into unique and valuable items. For example, turning old denim jeans into 
fashionable bags or using discarded wood to craft decorative furniture.
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 Ans 10. The United Nations Sustainable Development Goals (SDGs) are a set of 17 global 
objectives. Adopted in September 2015 by the United Nations General Assembly, 
they are designed to address a wide range of global challenges.

 (i) No Poverty: End poverty in all its forms everywhere.
 (ii) Zero Hunger: End hunger, achieve food security and improved nutrition, and 

promote sustainable agriculture.
 (iii) Good Health and Well-being: Ensure healthy lives and promote well-being 

for all.
 (iv) Quality Education: Ensure inclusive and equitable quality education and 

promote lifelong learning opportunities for all.

  The importance of SDG goals is:
 (i) They are universal and apply to all countries, regardless of their level of 

development.
 (ii) They acknowledge the interdependence of social, economic and environmental 

issues, promoting a holistic approach to development.
 (iii) They provide a long-term vision for addressing the world’s most pressing 

issues by 2030, fostering a sense of urgency and commitment to action.
 (iv) They hold governments and organizations accountable for their actions and 

commitment.

 Ans 11. Although sustainable development is crucial for addressing global challenges, it is 
not unaccompanied by problems and challenges in its implementation. Some of the 
key issues associated with sustainable development implementation are presented 
below:

 (i) Difficult to Balance: Sustainable development involves a complex web of 
social, economic and environmental factors that are interconnected. Finding 
solutions that balance these elements can pose a challenge, as decisions in 
one area may have unintended consequences in others.

 (ii) Short-Term vs. Long-Term Goals: There are trade-offs between short-term 
economic interests and long-term sustainability objectives. Policymakers and 
businesses may prioritize immediate gains over long-term environmental and 
social benefits.

 (iii) Resistance to Change: Transitioning to more sustainable practices often faces 
resistance from vested interests and traditional industries due to unwillingness 
to change age-old prevalent systems. This can form a hurdle in the progress 
towards sustainable development.

 (iv) Trade-Offs and Conflicting Objectives: Finding the right balance between 
economic growth, social equity and environmental protection can be challenging. 
Trade-offs may be necessary and different stakeholders may have conflicting 
priorities.

 (v) Global Cooperation: Many sustainability challenges, such as climate change 
and biodiversity loss, require international cooperation. Disagreements and 
geopolitical tensions can hinder effective global collaboration.

 (vi) Technological and Financial Barriers: Access to sustainable technologies and 
financial resources can be limited in many regions and poor nations, which 
restricts their ability to adopt and implement sustainable practices.

 Ans 12. A green economy is an economic system that seeks to promote sustainable 
development by incorporating principles and practices that reduce environmental 
risks and ecological scarcities. It aims to enhance human well-being and social 
equity.
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  The essential components of a green economy include:
 (i) Renewable Energy: The transition to renewable energy sources such as solar, 

wind, hydroelectric and geothermal power is the cornerstone of a green 
economy.

 (ii) Resource Efficiency: Resource efficiency involves using resources such as 
water, energy and materials more effectively to minimize waste and reduce 
environmental impact.

 (iii) Clean Technologies: The development and adoption of clean and eco-friendly 
technologies are crucial for reducing pollution and conserving resources. 
Examples include electric vehicles, energy-efficient appliances and sustainable 
building materials.

 (iv) Sustainable Agriculture: A green economy promotes sustainable farming 
practices that minimize the use of harmful chemicals, conserve soil and water, 
and protect biodiversity.

 (v) Circular Economy: The Circular Economy model focuses on reducing, reusing 
and recycling products and materials to minimize waste and extend the life 
cycle of products. It creates a closed-loop system where no one is unfamiliar 
with reusing and recycling resources.

 (vi) Biodiversity Conservation: Protecting and preserving biodiversity is integral 
to a green economy. It safeguards ecosystems, wildlife and natural habitats 
to maintain ecological balance and ecosystem services.

 Ans 13. Although sustainable development is crucial for addressing global challenges, it is not 
unaccompanied by problems and challenges in its implementation. Some of the key 
issues associated with sustainable development implementation are presented below:

 (i) Difficult to Balance: Sustainable development involves a complex web of 
social, economic and environmental factors that are interconnected. Finding 
solutions that balance these elements can pose a challenge, as decisions in 
one area may have unintended consequences in others.

 (ii) Short-Term vs. Long-Term Goals: There are trade-offs between short-term 
economic interests and long-term sustainability objectives. Policymakers and 
businesses may prioritize immediate gains over long-term environmental and 
social benefits.

 (iii) Resistance to Change: Transitioning to more sustainable practices often faces 
resistance from vested interests and traditional industries due to unwillingness 
to change age-old prevalent systems. This can form a hurdle in the progress 
towards sustainable development.

 (iv) Trade-Offs and Conflicting Objectives: Finding the right balance between 
economic growth, social equity and environmental protection can be challenging. 
Trade-offs may be necessary and different stakeholders may have conflicting 
priorities.

 (v) Global Cooperation: Many sustainability challenges, such as climate change 
and biodiversity loss, require international cooperation. Disagreements and 
geopolitical tensions can hinder effective global collaboration.

 (vi) Technological and Financial Barriers: Access to sustainable technologies and 
financial resources can be limited in many regions and poor nations, which 
restricts their ability to adopt and implement sustainable practices.

  Potential solutions to address these problems include following the SDGs with the 
aim to develop the community. SDGs provide a global framework for addressing 
interconnected issues such as poverty, inequality, environmental degradation and 
climate change. Tackling these issues require global cooperation.



SUBJECT-SPECIFIC SKILLS

CHAPTER 1: Digital Documentation (Advanced)

TEST YOUR KNOWLEDGE (Page 102)

Fill in the blanks
 1. Styles
 2. Manage Styles
 3. Alt+2 or F11 Function Key
 4. New Style from Selection
 5. Update Selected Style

Short Answer Questions
 1. Styles is a group of predefined formats saved by a specific name in the Styles 

Gallery. These Styles constitute a combination of font styles, colors, effects, 
indentation, alignment and suitable backgrounds that you can apply to selected 
pages, text, tables, lists, headings and other elements in a document to enhance 
their appeal.

 2. Following are the steps to create new Styles:
  (a) Click on Styles menu, then select the New Style from Selection option.
  (b) Enter the new Styles name and click the OK button.
  (c) Click on the portion of the document from where Styles has to be copied.
  (d) A New Style from Selection pop-up appears on the screen.
  (e) Select the text on which the new Styles is to be implemented.
  (f) To apply, double-click on the Styles name.
 3. To apply different formatting to newly created Styles, click on the Styles menu 

and then select Update Selected Style option or from Styles actions drop-down 
list displayed in the Styles pane of Sidebar.

 4. To load Styles from an existing document, we follow the below-given steps:
  (a) Open the document in which you want to copy the Styles.
  (b) Open Styles pane by pressing F11 key.
  (c) In the sidebar Styles pane, click on the Styles actions icon and select Load 

Styles from Template option from the drop-down menu. Then Load Styles 
from Template dialog box opens.

  (d) Select the desired Styles under Categories from Load Styles from Template 
dialog box and click OK.

 5. To create Styles using drag-and-drop method, follow the given steps:
  (a) Open the Styles window.
  (b) Select the desired Styles type button.
  (c) Select the pre-formatted text to be used as new Styles and drag-and-drop 

it into the pane. As a result, New Style from Selection pop-up shall be 
displayed.

  (d) Give an appropriate name to your Styles and click OK.
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TEST YOUR KNOWLEDGE (Page 121)

Fill in the blanks
 1. Ctrl and Shift
 2. Insert → Image
 3. Insert → Media → Gallery
 4. Drawing toolbar and Image toolbar
 5. Save a Copy

Short Answer Questions
 1. The various methods to insert an image in a Writer document are listed below:
  (a) Using Insert Menu
  (b) Using the Gallery
  (c) Linking Image
  (d) Using Scanner
  (e) Using Clipboard and Paste Special option
  (f) Using Drawing Toolbar for Shapes
 2. The steps to add images from a file are as follows:
  (a) Click on the Insert menu and select the Image option.
  (b) An Insert Image dialog box appears.
  (c) Select an image from the file and click the Open button.
  (d) The selected image will be inserted in a document.
 3. To insert images through Clipart in LibreOffice Writer, we need to perform the 

following steps:
  (a) Enable the Drawing Toolbar by View → Toolbars → Drawing.
  (b) Click on Insert Fontwork Text.
  (c) From the Fontwork Gallery, choose the appropriate clipart.
  (d) Enter the text and it will be displayed on the screen.
 4. Sometimes, when we want a section of an image in our document then we cut off 

the unnecessary parts of the image. This is known as cropping an image.
  To crop the image in LibreOffice Writer, perform the following steps:
  (a) Right-click on the image.
  (b) Select the Properties option and Image dialog box will be displayed on the 

screen.
  (c) On the Image dialog box, modify the values for left, right, top and bottom 

as per requirement.
  (d) Click the OK button.
 5. The Image toolbar is used to set the color, contrast, brightness as well as to crop 

and flip the image.
  The following options are present in the Image toolbar:
  (a) Filter—this is used to apply various filters on the selected image such as 

smooth, sharpen, aging etc.
  (b) Image Mode—this helps us to see the image in Default, Grayscale,  

Black/White and watermark mode.
  (c) Crop Image—it allows us to cut out some part of the image.
  (d) Flip and Rotate—these buttons help to flip the image vertically and 

horizontally and rotate the image at 90 degrees to left and right.
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  (e) Transparency—it helps to deal with the opacity of the image.
  (f) Color—it helps to change the color as well as brightness and contrast of the 

selected image.

TEST YOUR KNOWLEDGE (Page 135)

Fill in the blanks
 1. Table of Contents, Index or Bibliography
 2. 10
 3. Starting
 4. Paragraph
 5. Heading

Short Answer Questions
 1. Table of Contents can be described as a list with the headings of a document. 

It has title, headings and sub-headings placed in a document in a hierarchical 
manner. A Table of contents holds the numbered list of topics in a document and 
the page number with which they are associated. 

 2. Table of Contents depends on the headings in the document. Before using the 
Table of Contents feature one should make sure that the headings are indented 
properly and have the same styles.

 3. Headings are elements used to organize and structure written content. Headings 
help readers gain a clear understanding of the document by giving some insights 
to the topics that are going to be covered in each paragraph.

TEST YOUR KNOWLEDGE (Page 147)

Fill in the blanks
 1. Template
 2. New → Templates
 3. Templates
 4. Manage Templates
 5. Edit Template

Short Answer Questions
 1. Templates help us in saving a lot of time as it contains all the text, images, 

formatting, design and layout features imbibed in them.
 2. The steps to create a new template are:
  (a) Open a document.
  (b) Modify the document and Styles according to the preference.
  (c) Click on File → Save As option. Enter the relevant name of the template 

in the Save As dialog box.
  (d) Select the ODF Text Document Template (.ott) (.*ott) from the Save As 

type drop-down list.
  (e) Click on Save to save the new template.
 3. The steps to change the default template to a custom default template are as follows:
  (a) Select File menu → Templates → Manage Templates option.
  (b) Open the Category My Templates containing the saved template.
  (c) Right-click on that template and click on Set as Default option from the 

pop-up menu displayed.
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Unsolved Questions
 Ans 1. The steps to create a new style in LibreOffice Writer are given below:
  (a) Click on Styles menu.
  (b) Select New Style from Selection option.
  (c) Then New Style from Selection dialog box appears or press Shift+F11 

function key.
  (d) Enter a new style name and click OK button.

 Ans 2. To apply different formatting to newly created Styles or to update them, follow 
the given steps:

  (a) Go to the Styles pane by pressing F11. You can also click Styles menu and 
then select Manage Styles option which will display the Styles pane.

  (b) Select the Update Selected Style option from Styles menu or select the 
Update Selected Style option from Styles actions drop-down list displayed 
in the Styles pane of the sidebar.

  (c) Do the required changes to the document.
  (d) Click Save button to update the style.

 Ans 3. The steps to load Styles from an existing document are as follows:
  (a) Go to the Styles pane by pressing F11. You can also click Styles menu and 

then select Manage Styles option which will display the Styles pane.
  (b) Select the Load Styles from Template option from Styles menu or select 

the Load Styles from Template option from Styles action drop-down list 
displayed in the Styles pane of the sidebar.

  (c) From the Load Styles from Template pop-up, select the desired template 
style under Categories and click OK.

 Ans 4. Table of Contents (ToC) is a list of first-level headings of a document. A Table 
of Contents, like the Index or Contents, holds the numbered list of topics in a 
document and the page number with which they are associated. Similarly, each 
entry in a document relates the internal link to its contents.

 Ans 5. Table of Contents (ToC) depends mainly on the headings in a document. Before 
using this feature, make sure that the headings are indented properly and have 
the same Styles. LibreOffice Writer contains predefined standard headings such as 
Heading 1, Heading 2, Heading 3, etc.

 Ans 6. Headings in LibreOffice Writer are titles or labels that are applied to different 
sections of a document to organize and structure content. These are formatted 
differently from regular text, helping to highlight their importance or hierarchy. 
In LibreOffice Writer, these headings are used to create a Table of Contents (ToC). 
LibreOffice provides ten levels of headings.

 Ans 7. (a) Anchoring: Anchoring is a reference point for shapes/images. This reference 
point can be page or frame and the object can be a paragraph or character. 
You can always find an anchor point for an image. Anchor option present in 
Format menu provides various options such as Bring to Front, Forward One, 
Back One, Send to Back and To Background.

  (b) Text wrapping: With the help of the Wrap option available in the Format 
menu, the inserted object, shape or image will be arranged with respect to 
the text. It provides various types of text wrapping such as text flows around 
the image/shape, may be placed before or after the image, beside the image, 
etc.
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 Ans 8. A template is a blank document with applied formatting that acts like a fill-in-the- 
blank document that you can use to create other documents. Templates contain 
elements that regular documents usually comprise such as text, graphics, headings, 
titles, a set of styles, and other set-up information like language, default printer 
and toolbar menu customization.

  The advantages of using a template are—it saves time and money, it improves 
execution of a document and the chances of errors are reduced while creating new 
documents.

 Ans 9. Difference between Styles and Templates

Styles Templates
Styles are defined as the collection of 
predefined formats.

Templates are defined as the predesigned 
documents.

They are applied to text or objects of a 
document.

They are used as starting point for new 
documents

They can be customized. They can be created or updated.
Examples: Paragraph Styles, Character 
Styles, etc.

Examples: Business Correspondence, 
Localization, etc.

 Ans 10. The steps to group drawing objects in LibreOffice Writer are as follows:
  (a) Select the first object, press and hold the Shift key and then select the other 

objects that we want to group.
  (b) Click the Group button on the Object Properties Toolbar.

OR
   Right-click the selected objects and choose the Group option from the context 

menu.

 Ans 11. Follow the given steps to create a new template:
  (a) Open a new text document of LibreOffice Writer.
  (b) Click on File → New → Templates.
  (c) Templates dialog box will appear.
  (d) Choose the category from the All Categories drop-down list and then select 

any template of the chosen category by double clicking on it.
   Then click on the Open button and it displays the selected template document.

 Ans 12. Styles can be created using the drag-and-drop method by following these steps:
  (a) Open the Styles window.
  (b) Select the desired Styles type button.
  (c) Select the pre-formatted text to be used as a new Styles, and drag-and-drop it 

into the pane. As a result, the New Style from Selection pop-up will appear.
  (d) Give an appropriate name to your Styles and click OK.

 Ans 13. Graphics or images add clarity and better understanding to the text in a document. 
Images make documents attractive by breaking up text monotony, capturing attention 
and aiding in information comprehension. They illustrate concepts, support ideas 
and enhance the overall visual appeal of the document.

 Ans 14. Images can be inserted in a Writer document by using any of the following methods:
  (a) Using Insert Menu for getting images from a file.
  (b) From the LibreOffice Gallery option present on the right sidebar.
  (c) From Link Image by clicking on the Link check box which inserts the image 

through the insert menu.



Book-X 29

  (d) If a Scanner is attached to the computer, directly scan and place an image 
in the document.

  (e) Using Clipboard and Paste special option.
  (f) Using a Drawing Toolbar for Shapes.

 Ans 15. To insert images from a file, follow these steps:

  (a) In the document, place the cursor where you want to insert an image.
  (b) Click on the Insert menu and select the Image option.
  (c) The screen will display the Insert Image dialog box. Choose the required 

image from the displayed options (choose from a sub-folder/image) and click 
on the Open button. The image will be inserted at the desired place in the 
document.

 Ans 16. The steps to group drawing objects in Writer are as follows: (CBSE 2024)

  (a) Select the first object, press and hold the Shift key and then select the other 
objects that we want to group.

  (b) Click the Group button on the Object Properties Toolbar.

OR
   Right-click the selected objects and choose the Group option from the context 

menu.



CHAPTER 2: Advanced Electronic Spreadsheet

TEST YOUR KNOWLEDGE (Page 167)

Fill in the blanks
 1. Consolidating data
 2. Subtotals
 3. Columns
 4. Link to source data
 5. Data
 6. Group By
 7. Outline

Short Answer Questions
 1. Data Consolidation is the process of combining varied data organized in different 

sheets or sources into one worksheet or a single destination.
 2. Subtotals is a powerful feature of LibreOffice Calc software to analyze data. It is 

an easy and quick method that automatically organizes the selected data range 
into groups to calculate automatic subtotals by applying common functions like 
Sum to the grouped data.

 3. The significance of selecting the Function option present in the Consolidate dialog 
box is that the dialog box provides several types of functions that can be applied 
to the table. Some of the functions include Sum, Count, Average, Max, Min, etc.

 4. To add data from one worksheet to another worksheet, we can use the following 
syntax:

  “Sheet_name.First_cell:Last_cell”
  where Sheet_name is the name of the file, and
  First_cell:Last_cell is the range of cells that will be used for referencing.
  We can apply this syntax on the cell in which we want to have the data from 

another sheet.
 5. Consolidation ranges list is the feature used for combining data from multiple 

ranges into a single range. These ranges can be in the same sheet as well as 
across multiple sheets.

TEST YOUR KNOWLEDGE (Page 177)

Fill in the blanks
 1. What-if
 2. Tools
 3. Sheet1_Scenario_1
 4. Tools

Short Answer Questions
 1. Scenarios can be defined as a set of multiple values for the same cell in the existing 

dataset that can be used for doing calculations and data analysis. We also use 
scenarios when we have to create different target-based “what-if” analyses.

 2. Navigator helps to choose scenarios by giving a drop-down list of scenarios.
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 3. Multiple Operations is the function that we use to apply the same formula to 
different cells but we can change the parameters by assigning them different 
values. This command can be found under the Data Menu.

 4. Formula cell—In the Formula cell, the reference of the cell which contains the 
formula we want to resolve is entered. It contains the current cell reference.

  Target value—It refers to the target value that we want to achieve through the 
entered formula.

  Variable cell—This cell contains the unknown value that we want to find and 
adjust in order to achieve the desired value.

 5. 
Goal Seek Solver

(a) Finds an input value to achieve a 
specific target result in a formula.

Optimizes a result based on multiple 
variables and constraints.

(b) Works with a single variable. Handles multiple variables.
(c) Simple what-if analysis tool. Used for complex optimization problems.

 6. The Solver is an advanced form of Goal Seek tool because in Goal Seek, we get 
the desired result just by changing the value of one variable while using Solver, 
we obtain the desired result by changing multiple values which gives us more 
power to try out several combinations of values for different variables.

TEST YOUR KNOWLEDGE (Page 189)

Fill in the blanks
 1. Macros
 2. Tools
 3. Run Macro
 4. Arguments
 5. getValue(), getString(), getFormula()

Short Answer Questions
 1. Macros is a saved sequence of commands or keystrokes that one can store for later 

use and run as many times as he wants.
 2. Recording a macro helps to automate repetitive tasks thereby saving time and 

reducing the chances of errors which helps in enhancing the productivity of users 
and helps them to focus on important non repetitive work.

 3. To record a macros, one can follow the given following steps:
  (a) Go to tools → Macros → Record Macros to start recording a macro, a dialog 

box with a button stop recording button is displayed. 
  (b) Enter the desired text that you want to enter.
  (c) Click the stop recording button.
  (d) Save the recorded macro by clicking on the save button. 
 4. Ms. Arshpreet can create a macros to generate a sample copy of the worksheet with 

marks for her Class X students. Firstly, she can record her actions on inputting 
sample marks for one student in each subject. Now, whenever she wants to generate 
a sample worksheet, she just needs to run that macros and LibreOffice Calc will 
automatically create a sample worksheet for her.
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 5. We can sort columns using Macros by following the given steps:
  (a) Choose the cells.
  (b) Select Tools → Macros → Record Macro option. 
  (c) Click on the Sort Ascending button from the Standard Toolbar.
  (d) Click on the Stop Recording button. 
  (e) Name your Macros and Save it using the Save button.

TEST YOUR KNOWLEDGE (Page 205)

Fill in the blanks
 1. Cell Reference
 2. Ctrl+N
 3. Hyperlink
 4. Absolute and Relative
 5. Internet

Short Answer Questions
 1. There are several ways to insert a new worksheet as follows:
  Click ‘+’ symbol to insert a new sheet after the default sheet.
    OR
  Go to Sheet menu → click Insert Sheet option from the Menu bar.
    OR
  Select Insert Sheet option by right-clicking on the Sheet tab.
    OR
  Insert Sheet dialog box appears. Select the place where you want to insert the 

worksheet. You can either select Before current sheet or After current sheet.
 2. The steps to create references from other documents using a computer mouse are 

as follows:
  (a) Click on the cell in which you wish to apply the cell referencing.
  (b) Type equals to (=) sign in the cell from where the reference is to be made to 

the other sheet.
  (c) Now, click on the name of the sheet and then on the desired cell and press 

Enter.
 3. Hyperlink refers to some text or data that shall open another linked file, worksheet 

or document, when clicked.
 4. We rename a worksheet so that the worksheet has some rational name.
  Having a rational name helps to clarify the purpose of each sheet and makes it 

easier to navigate among different sheets.

TEST YOUR KNOWLEDGE (Page 210)

Fill in the Blanks
 1. Tools
 2. Shared
 3. red
 4. disabled
 5. Shared or collaboration
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Short Answer Questions
 1. Sharing worksheet data is useful because it allows multiple users to collaborate, 

edit and view information simultaneously which helps us to achieve teamwork, 
reduce errors and also helps to increase productivity.

 2. To share a spreadsheet, follow the steps given below:
  (a) Click on the Tools menu and then select Options.
  (b) Enter all address details and click OK.
  (c) Open the previously created spreadsheet.
  (d) Click on the Tools menu and select Share Spreadsheet option.
  (e) From the Share Document dialog box, select Share this spreadsheet with 

other users checkbox and click OK.
  (f) Click Yes in the confirmation dialog box.
 3. When one opens a spreadsheet document that is in shared mode, he/she will receive 

a message that the document is in shared mode and that some features cannot 
be accessed in this mode.

TEST YOUR KNOWLEDGE (Page 220)

Fill in the blanks
 1. Track Changes
 2. Edit, Track Changes → Record
 3. comments
 4. Insert → Comment
 5. Show Comment

Short Answer Questions
 1. When we click on the Manage option from the sub-menu of Track Changes option 

present in the Edit menu, the Manage Changes dialog box appears. This dialog 
box helps us review the changes recorded by selecting the Track Changes → 
Record option. The Manage Changes dialog box displays a list of all the changes 
made in a spreadsheet, including the Action, Position, Author, Date and Comment. 
It also provides options to Accept, Reject, Accept All or Reject All changes by 
selecting the respective buttons.

 2. Adding Comments in a spreadsheet helps to clarify the data. It makes it easy to 
work with the information by allowing collaboration, highlighting important details 
and improving understanding of the data inside the spreadsheet.

 3. The steps to insert/add a new comment are as follows—
  (a) First of all, select a cell then right-click on that selected cell.
  (b) Click on the Insert Comment option from the pop-up menu which appears 

by right-clicking the cell.
  (c) A yellow-colored box appears for writing the desired comment. Click outside 

the box.
 4. The steps to edit the added comment are as follows:
  (a) Select the cell with the comment you want to edit.
  (b) Right-click on the selected cell with the comment marker and click on Show 

Comment in the pop-up menu.
  (c) Double-click on the cell where the comment is to be edited.
  (d) When the cursor changes to the usual blinking text-entry cursor, make the 

necessary changes to the already existing comment
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  (e) Once done, click outside the comment. Right-click on the cell and deselect 
Show Comment on the pop-up menu to hide the changes which are reflected 
with a colored outline border, can be easily identified and the owner can 
either accept or reject those changes as required.

 5. To review and accept all the changes incorporated by a user in a spreadsheet, one 
can follow these steps:

  (a) Open the edited worksheet.
  (b) Click on the Manage option under the Track Changes option of the Edit 

menu.
  (c) A Manage Changes dialog box will be displayed to review all the changes.
  (d) Then the user can accept all the changes by clicking on the Accept All button.

Unsolved Questions
 Ans 1. The steps to create references from other documents using mouse are as follows:
  (a)  Click on the cell in which you wish to apply the reference of a cell in another 

sheet.
  (b) Type an equal to (=) sign in the cell from where the reference is to be made 

to the other sheet.
  (c) Now, click on the name of the sheet and click on the desired cell. Press Enter 

and repeat the same steps for the remaining cells.

 Ans 2. Data consolidation is a process in which the data of similar type, available in 
multiple worksheets (located in one or multiple workbooks), is gathered, and 
consolidated into a single worksheet and then saved for further data analysis.

 Ans 3. The hyperlink types options available in the Hyperlink dialog box are:
  (a)  Internet: This option allows you to create a hyperlink to a website or a 

specific web page. You can enter the URL in the designated field.
  (b)  Mail: This allows you to create a hyperlink to an email address.
  (c)  Document: This type of hyperlink is used for linking to another document. 

You can select a document from your file system and click the hyperlink to 
open that document.

  (d)  New Document: Creates a hyperlink to a new, blank document.

 Ans 4. The steps to create a hyperlink are:
  (a) Select the cell where a hyperlink is to be created and inserted
  (b) Go to Insert > Hyperlink
  (c) This will open the Hyperlink dialog box
  (d) Choose the hyperlink type
  (e) Enter details (URL, text, email, path, etc.)
  (f) Click Apply or OK to insert
  (g) Test the hyperlink by clicking the cell

  The Hyperlink dialog box in LibreOffice Calc allows you to create hyperlinks. It 
includes fields to specify the hyperlink type (Internet, Mail, Document, etc.), enter 
the URL or path and set further settings. After entering the details, click Apply 
to insert the hyperlink.

 Ans 5. Follow the given steps to create a reference using a keyboard in the same worksheet:
  (a) Click on the cell where you want to enter the reference.
  (b) Start the formula by typing the equal to (=) sign.
  (c) Use the arrow keys on your keyboard to navigate to the cell you want to 

reference.
  (d) Once you are in the target cell, press Enter key on your keyboard.
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 Ans 6. Scenarios are a what-if analysis tool that helps to create different target-based 
‘what-if’ analyses. Scenarios can be defined by a set of multiple values for the 
same cell in the existing data set that can be used for doing calculations and data 
analysis. It is a model wherein changes in the original dataset are made by the 
user to analyze the changes in the possible outcome.

 Ans 7. We can create a reference to cells located on other worksheets within the same 
workbook by using the sheet name followed by a dot operator/mark (.) and then 
specifying the cell or range of cells.

  The syntax for creating the cell reference to another sheet in the same workbook 
is:

  Reference to a range of cells—
  Syntax: Sheet_name.First_cell:Last_cell
     Or
  Sheet_name.cell_range
  For example, Sheet1.B1:B15
  Reference to an individual cell—
  Syntax: Sheet_name.cell_address
  For example, Sheet1.B18
  The two parts of a cell reference are - Column Letter and Row Number.
  Column Letter identifies the column whereas Row Number identifies the row.
  For example, in the cell reference B8, B is the column and 8 is the row. 
  Therefore, B8 refers to the cell where column B and row 8 intersect.

 Ans 8. Goal Seek is an important what-if analysis tool offered by Calc. It helps us to do 
backward calculation and analysis of input to obtain the desired result or output. 
It allows the user to analyze the impact of a change made on any data value due 
to any change made in another associated data value. This is why Goal Seek is 
also called the Back-solving method.

 Ans 9. We can use Navigator for creating a scenario by following these steps:
  (a) For creating scenarios, select the entire range of cells and then click on  

Tools menu → Scenario option.
  (b) Create Scenario dialog box will open. Give a relevant name to the scenario. 

Checkboxes Display border and Copy back are selected by default, which we 
will continue with.

  (c) Select a color for creating a border to the created scenario and click OK.
  (d) In order to switch over to other created scenarios, click on Navigator present 

on the right side of the scenario title area. The names of all the scenarios 
which the user creates shall be displayed in the Navigator.

   Thus, we can create different scenarios from the Navigator.

 Ans 10. LibreOffice Calc allows multiple users to access and modify a file at the same time. 
It can be the same spreadsheet/workbook that can be placed on the network so 
that it can be shared by several users. An important advantage of sharing files in 
collaboration is that you can keep track of the changes made by other users and 
can accept or reject these without keeping track of multiple versions.

 Ans 11. Some advantages of sharing worksheet data are:
  (a) It allows multiple users to access and modify a file at the same time.
  (b) Data can also be modified simultaneously.
  (c) Keeps track of the changes made by other users.
  (d) Accepts or rejects these changes without keeping track of multiple versions.
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 Ans 12. The steps required to share a spreadsheet are:
  (a) Click on the Tools menu and then select Share Spreadsheet Option.
  (b) Share Document dialog box gets displayed.
  (c) Select the Share this spreadsheet with other users checkbox to enable 

sharing this spreadsheet.
  (d) Click OK and save the spreadsheet.
  (e) On the title bar next to the document title, the word shared shall be displayed.

 Ans 13. The options available in Share Workbook dialog box are:
  (a) Share this spreadsheet with other users checkbox to enable/disable 

sharing the spreadsheet.
  (b) List of Users Currently Accessing this Spreadsheet.
  (c) Help, Ok and Cancel buttons to modify changes.

 Ans 14. Track Changes in a shared spreadsheet shows who made changes and when they 
made changes which helps the team to work transparently. The advantage of  
using track changes is that it helps in version control, communication, conflict 
resolution, etc.

 Ans 15. Comments display what is changed by other users (for example, the value in Cell 
C5 changed from ‘1000’ to ‘400’). Collaborators, reviewers and authors can add 
their comments for the changes made, along with relevant and necessary reasoning 
wherever required. Comments are often used to exchange ideas, ask for suggestions 
or brainstorm a document.

 Ans 16. The process of inserting a new comment includes the following steps:  
 (CBSE 2024)

  (a) Click and select the desired cell where the comment is to be inserted
  (b) Right-click in the active cell and select the Insert Comment option from the 

pop-up menu or can select the Insert Comment option from Insert menu
  (c) The Comment Box will get displayed
  (d) Type the desired comment and click outside the box
  (e) The cell inserted with the comment has a colored dot in the upper right-hand 

corner
  (f) Hover over or point to the cell in which the comment is added. The comment 

will be displayed

 Ans 17. By following the given steps, we can accept all the changes done by a user in a 
spreadsheet:

  (a) Open the edited worksheet.
  (b) Click on the Edit menu and then select the Track Changes option.
  (c) Click on Manage option from the displayed sub-menu.
  (d) Manage Changes dialog box shall be displayed on the screen.
  (e) Click on Accept All button and hence all the changes will be accepted.
  (f) To close the dialog box, click on the Close button present at the bottom right.

 Ans 18. By following the given steps, we can reject changes one at a time:
  (a) Open the edited worksheet
  (b) Click on the Edit menu and then select the Track Changes option
  (c) Click on Manage option from the displayed sub-menu
  (d) Manage Changes dialog box shall be displayed on the screen
  (e) Depending on the requirement and the suggested review, click on Reject for 

the selected change
  (f) To close the dialog box, click on the Close button present at the bottom right
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 Ans 19. We can link a worksheet with another spreadsheet in the same or different workbook 
through hyperlinks by following the given steps:

  (a) Click the cell to be selected in the worksheet where a hyperlink is to be 
created and inserted

  (b) After clicking on the Insert menu, select the option Hyperlink
  (c) This will display the Hyperlink dialog box
  (d) Click and select Document on the left-hand panel of the Hyperlink  

dialog box
  (e) Click on the Open File button. Open dialog box gets displayed on the screen
  (f) Browse the target document location and then select the file
  (g) Click Open. The selected path shall be displayed in the Hyperlink dialog box
  (h) Click on the Target in document button in Target in document field
  (i) Select the Target sheet and Click Apply button on the Target in Document 

dialog box
  (j) In the Text box under Further settings area, type the text to be displayed 

in the cell
  (k) Click on Apply and then click on Close button to complete the process of 

linking

 Ans 20. The steps to compare the spreadsheets are:
  (a) Open the original document and the edited document that you want to compare
  (b) Click on the Edit menu and select the Track Changes option. Then select 

the Compare Document option from the sub-menu
  (c) The Compare to Original Document dialog box shall be displayed
  (d) Choose the original worksheet and click on the Open button
  (e) The Manage Changes dialog box opens, containing the list of changes
  (f) Calc will mark the changes as inserted, deleted and changed
  (g) You can then accept or reject changes from the Accept or Reject Changes 

dialog box
  For merging spreadsheets, follow the given steps:
  (a) Open the original document
  (b) Go to Edit → Track Changes → Merge Document
  (c) Choose the worksheet you want to merge from the Merge with dialog box
  (d) The Manage Changes dialog box gets displayed, showing the change done 

by more than one reviewer
  (e) Click on Accept or Reject or Accept All or Reject All option as per 

requirement
  (f) Click on the Close button to close the Accept or Reject Changes dialog 

box
  (g) Finally, all the changes made are merged into one document

 Ans 21. The purpose of consolidating data in spreadsheets as it allows us to combine the 
contents of several spreadsheets or workbooks into one sheet. By consolidating 
data, we can easily use specific functions such as Sum, Count, Min, etc. on a given 
dataset. This method is better and easier than creating and typing out individual 
formulas. It also helps save time, reduces the chance of errors and makes it easier 
to analyze and compare information from different sources. 

  For example, if Unit Tests scores for mid-terms, end-terms are recorded on separate 
sheets, we can use data consolidation to display the combined total in one place, 
such as a summary sheet.
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 Ans 22. The two parts of a cell reference while referencing data on other sheets are - 
  Sheet Name and Cell Address.
  For example, the cell reference Sheet2.A3 refers to cell A3 on Sheet2.

 Ans 23. The four types of hyperlinks that can be applied in spreadsheets are:
  (a) Internet: this option creates a hyperlink to a web page (URL).
   For example: https://www.libreoffice.org
  (b) Mail: this option creates a hyperlink that opens the default email program 

with a pre-filled recipient address.
   For example: mailto:inform@mighle.com
  (c) Document: this option links to another file or to a specific location (cell or 

sheet) within the same spreadsheet or a different document.
   For example: Link to Sheet2.A1 
  (d) New Document: this option creates a hyperlink that, when clicked, opens 

a new document, which can be created immediately or later.
   For example: Link to create a new Calc or Writer document.



CHAPTER 3: Database Management System

TEST YOUR KNOWLEDGE (Page 238)

Fill in the blanks
 1. Database
 2. Database Management System
 3. Flat File
 4. Database Servers
 5. Back-end

Short Answer Questions
 1. DBMS stands for Database Management System.
  A Database Management System is a software system or a set of computer programs 

that allows the users to create, retrieve and update information in a database. 
It is an integrated and systematic arrangement of data, files, records and other 
objects which uses a database in a fast and efficient way.

 2. Flat file is a data model that consists of only one table. All the relevant and 
required fields are included in this single table.

  On the other hand, the relational data model overcomes the limitations of the single 
or flat file model. Unlike flat files, the relational model stores data in multiple 
tables which are linked to each other through a common field (known as key).

 3. The advantages of database are as follows:
  (a) It gives a structured and efficient way to store large volume of data.
  (b) It makes data accessible to users and applications, enabling the retrieval of 

information as needed.
  (c) It helps to maintain data integrity and reduce data redundancy through 

normalization.
  (d) It allows multiple users and applications to share data, facilitating collaboration 

and data exchange.
 4. Data Redundancy refers to the duplication of data within a database. It happens 

when the same information is stored multiple times across different locations or 
tables.

 5. Data Integrity refers to the enforcement of rules so that the accuracy, consistency 
and reliability of data can be maintained through the life cycle of data. Maintaining 
data integrity is crucial for ensuring truthfulness in data.

TEST YOUR KNOWLEDGE (Page 244)

Fill in the Blanks
 1. Tuples, Attributes
 2. Primary Key
 3. Domain of Relation
 4. primary
 5. Alternate
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Short Answer Questions
 1. The various database objects include:
  (a) Table: It is a combination of rows and columns. It helps to organize data 

and acts as a container that holds data related to a specific entity.
  (b) Query: It is a request made to a database for retrieving the required 

information.
  (c) Form: It helps a user to enter data into the database.
  (d) Report: It is a formal and formatted representation of data and contains 

useful data for analysis and decision-making and is obtained as a result of 
database queries.

 2. Some examples of database systems are: MySQL, PostgreSQL, MS Access, IBM 
Db2, MongoDB, Cassandra, LibreOffice Base, etc.

 3. Primary key is an attribute or a group of attributes that can uniquely identify 
tuples within a relation while foreign key is a non-key attribute whose values are 
derived from the primary key of some other base table.

  The primary key of one table is often referenced as a foreign key in another table 
to establish relationships between the tables.

 4. Relational Database Management System or RDBMS is a special database software 
required to store, maintain and retrieve data from multiple tables into a single 
database.

  RDBMS helps to organize data into tables, rows and columns and thus provides 
a structured and efficient way to store and retrieve information.

 5. Form in DBMS is a way through which a user can enter data whereas query is 
a request made to a database for retrieving the required information.

TEST YOUR KNOWLEDGE (Page 257)

Fill in the Blanks
 1. Columns, rows
 2. Attribute or Field or column
 3. Row or Tuple
 4. Data types
 5. two or more

Short Answer Questions
 1. There are two ways to create a table in LibreOffice Base:
  (a) Create Table in Design View — We can follow the given steps to create 

a table:
 (i) Click on Create Table in Design View from Tasks pane.
 (ii) In the Table Design window, under field name, specify the field names 

for the table and their type.
 (iii) Set the field properties and its parameters.
 (iv) Enter the field name one by one and its type from the drop-down menu.
 (v) Save the table from File → Save as option and click the OK button.
  (b) Creating a Table using Table Wizard — We can follow the below-given 

steps to create a table:
 (i) Under the Database side panel, click on the Tables component and in 

the tasks pane, select Use Wizard to Create Table.
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 (ii) In the Table Wizard dialog box, select the required Category, table 
from Sample tables and add the desired fields from the Available fields 
sections, respectively, and click Next.

 (iii) Set the preferred properties for the respective fields.
 (iv) Create a primary key (optional).
 (v) Name your table and click Finish.
 2. The various datatypes used in DBMS/RDBMS are as follows:
  (a) Numeric types like Integer, Decimal, Floating Point, etc.
  (b) Alphanumeric types like Char, Varchar, Text, etc.
  (c) Binary types like LongVarBinary, VarBinary, etc.
  (d) Data & Time
 3. Numeric data types include Boolean, TinyInt, SmallInt, Integer, bitInt, etc.
 4. Alphanumeric data types include LongVarChar, Char, Varchar, etc.
 5. A table in a database is a combination of rows and columns. Each row represents a 

single record and each column defines the type of information stored in it. Table helps 
organize the data logically, making, updating, retrieving and manipulating it easily.

TEST YOUR KNOWLEDGE (Page 269)

Fill in the Blanks
 1. Tables
 2. Three
 3. Integrity constraints
 4. Primary Key and Foreign Key
 5. Referential Integrity

Short Answer Questions
 1. The file extension used by LibreOffice Base to create a database is
  .odb (open database).
 2. The file formats supported by LibreOffice Base are:
  (a) .odb (open database)
  (b) .odf (open document format)
  (c) .odt (open document text)
 3. The types of relationships that can be created in LibreOffice Base are:
  (a) One-to-One: One tuple at most is associated with one tuple of another table.
  (b) One-to-Many: One tuple can reference one or more tuples of another table 

but the other table can reference one tuple of the first table.
  (c) Many-to-Many: Multiple tuples of one table can have multiple matching 

with tuples of another related table.
 4. Sorting is defined as arranging the data in ascending or descending order.
  To sort the data stored in a table, we can click on the column and then click the 

Sort Ascending or Sort Descending button to sort the data accordingly.
 5. Referential Integrity helps to make the table remain consistent, i.e., if one table 

has a foreign key referring to another table’s primary key, the value in the foreign 
key must exist in the table that is being referenced to.

  For example, in a case where the ‘Orders’ table references the ‘Customers’ table 
using a foreign key ‘CustomerID’, if a customer record is deleted from the ‘Customers’ 
table, the corresponding records in the ‘Orders’ table with the same ‘CustomerID’ 
are either deleted or set to default values to maintain data integrity.
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TEST YOUR KNOWLEDGE (Page 280)

Fill in the Blanks
 1. Query
 2. SQL
 3. Criterion
 4. Selecting Queries
 5. Query Design View
 6. Query Wizard

Short Answer Questions
 1. A query is defined as a request made to a database for retrieving the required 

information. Running a query is like asking a detailed question from a database.
 2. The different ways provided by LibreOffice Base to perform a query are:
  (a) Query Design View
  (b) Query Wizard
  (c) SQL View
 3. The steps to create a query using Query wizard are as follows:
  (a) Select Queries from the Database pane and then click Use Wizard to Create 

Query in the Tasks pane.
  (b) In the Query Wizard dialog box, select the desired table and add the required 

fields in the query and click Next.
  (c) Select the fields on which you want to sort the data.
  (d) Specify the search condition to be applied for filtering the records from the 

table matching the given condition.
  (e) Select an option, either “Detailed query” or “Summary query”, as per the 

requirements. Click Next.
  (f) Perform Aliasing if required.
  (g) Enter the relevant name of the query and click Finish.
 4. Query Design View in LibreOffice Base offers a GUI for visually designing query 

by providing users the feature of drag-and-drop tables and fields, specify criteria, 
relationships, etc., thereby giving more control over query creation. On the other 
hand, Query Wizard is a step-by-step process of query creation thereby giving less 
control as compared to Query Design View over query creation.

 5. In Query Design, we can understand Criteria as a way to give constraints or 
conditions or rules that will be applied on the queries.

Unsolved Questions
 Ans 1.  DBMS stands for Database Management System.

 Ans 2. RDBMS stands for Relational Database Management System. It is a special database 
software required to store, maintain and retrieve data from multiple tables present 
in a single database. It is used to define and build a strong relationship between 
database tables.

 Ans 3. RDBMS works with a relational database, which comprises multiple data sets 
organized in the form of two or more tables and their respective records and 
columns.
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 Ans 4. In LibreOffice Base, we can create tables in the following two ways:
  (a) Create Table in Design View
  (b) Use Wizard to Create Table
 Ans 5. Data types in DBMS/RDBMS are used to identify which type of data we are 

going to store in the database. Fields in a table can be of various types depending 
on the data values they contain. Once a data type has been defined, it will not 
accept a different type of data. If data of some other type is entered into a field 
other than its defined data type, then it will result in an error. They contribute 
to the consistency, reliability and efficiency of database management by providing 
structured rules for data representation and manipulation.

 Ans 6. We can change a field’s width and position in a form by right-clicking on the 
desired control of a form and selecting the Control Properties option. The Properties: 
Multiselection window will be displayed, showing a sequence of properties such as 
Width, PositionX, PositionY, etc.

 Ans 7. The components of Query Design area while creating a Query in Design View are 
as follows:

  (a) Table Pane—This area displays the tables or queries added to the query 
design. Each table appears as a box listing its fields.

   We can do the following:
 (i) Add tables or queries using the Add Tables or Query dialog box.
 (ii) View and select fields to include in your query.
 (iii) Establish relationships between tables by dragging fields from one table 

to another.
  (b) Toolbar—it is located at the top, the toolbar provides quick access to various 

functions, such as:
 (i) Running the query to view results.
 (ii) Saving the query.
 (iii) Switching between design and SQL views.
 (iv) Adding or removing tables from the design
  (c) Grid Area—it is also known as the Query Design Grid, allows us to specify 

details for each field in your query.
                 The various components of Grid Area are:
 (i) Field: Shows fields used in the query
 (ii) Alias: Displays an alternate name of the field which can be modified if 

required
 (iii) Table: Lists the table each field is from
 (iv) Sort: Allows you to choose a sort order for the query
 (v) Visible: Unchecks field boxes for the fields you do not want to display 

in the query result
 (vi) Function: Allows you to select a function for the query
 (vii) Criterion: Specifies record filter criteria in the row
 (viii) Or: Specifies ‘or’ criteria in the row
 Ans 8. Yes, queries can be created on multiple fields. For example, if you want to extract 

records based on specific criteria involving multiple columns, you can specify 
conditions in the “Criterion” section below each required field. Use the “Or” section 
for conditions where any one of them should be true. For instance, a query could 
be created to display records where ‘Fee’ is greater than or equal to 4000 and 
‘NoOfCredit’ achieved by students is less than 3. After specifying the conditions, 
click ‘Run Query’ or press F5 to see the matching records in the output.
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 Ans 9. There are two ways to create forms in a database:
  (a) Create Form in Design View
  (b) Create Form using Wizard
  On the other hand, reports can be created using the Use Wizard to Create Report 

option.

 Ans 10. The advantages of establishing relationships between tables in a database are as 
follows:

  (a) It saves time as common data is not required to be repeated in different 
tables.

  (b) It reduces the chances of storing erroneous data.
  (c) It creates or summarizes data from two or more related tables at a particular 

time.

 Ans 11. The two benefits of creating relationships between tables in a database are as 
follows: (CBSE 2024)

  (a) It saves time as common data is not required to be repeated in different 
tables.

  (b) It reduces the chances of storing erroneous data.

 Ans 12. (i) Database: It is an organized collection of interrelated data that serves multiple 
applications. For example, a School database may include tables related to 
students, teachers, results, etc. (CBSE 2024)

  (ii) Table: It is a combination of rows and columns. In the relational model, 
a table is referred to as a relation, which is a combination of tuples and 
attributes.

   We can also say that it is a named collection of data items which represents 
a complete unit of information. For example, tables like Student, Employee, 
etc.

  (iii) Field: It is a set of characters used to represent values of a certain type.  It 
can also be referred to as a column or attribute. For example, in the Student 
table, fields include Rollno, Stu_Name, DOB, etc.

  (iv) Composite Primary Key: A primary key can be a combination of more than 
one field, called a composite primary key. For example, in the Sales table, 
the combination of Cust_Id and Product_Id is defined as a composite primary 
key.



CHAPTER 4: Maintain Healthy, Safe and Secure Working 
Environment

 Ans 1. The various workplace safety hazards are as follows: 
  (a) Physical hazards
  (b) Electrical hazards
  (c) Fire and explosive hazards
  (d) Ergonomic hazards
  (e) Chemical hazards
  (f) Biological hazards

 Ans 2. The potential sources of hazards in an organization are as follows:
  (a) Poor ergonomics
  (b) Inadequate electrical systems
  (c) Fire and explosion risks
  (d) Improper handling of office equipment
  (e) Lifting or moving objects
  (f) Stress at work
  (g) Working environment

 Ans 3. Some workplace hazards that can occur in the IT industry are as follows:
  (a) Ergonomic hazards
  (b) Electrical hazards
  (c) Sleeping problems due to artificial lightning
  (d) Injuries from laptop use
  (e) Stress disorders
  (f) Vision health
  (g) Musculoskeletal disorders
  (h) Slips, trips and falls

 Ans 4. Workplace safety rules are guidelines designed to keep everyone safe while working. 
They help prevent accidents and ensure a healthy environment for all employees.

  Safety guidelines must be followed to ensure a safe working environment such as:
  (a) Regular inspection and audit must be carried out at the workplace.
  (b) Ensure all machinery is properly guarded and maintained, also trained 

employees for safe operation.
  (c) Maintain a clean and organized workplace, with proper lightning, ventilation 

and noise control to prevent accidents.
  (d) Security policies and procedures must be updated regularly to avoid workplace 

hazards.
  (e) Design the workplace ergonomically, providing adjustable furniture and 

ensuring tools and equipment are within easy reach.

 Ans 5. The various types of emergencies are as follows:
  (a) Medical Emergencies - injuries, sudden heart attacks, severe bleeding, broken 

bones, etc.
  (b) Fire and explosion -  fire outbreaks, gas leakage, chemical exposure.
  (c) Natural Disasters - earthquakes, floods, hurricanes, etc.
  (d) Radiation Emergencies - workplace is exposed to harmful radiation, such as 

emergencies requiring containment and specialized, medical treatment.
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 Ans 6. Emergency: An emergency at the workplace is an event that occurs and creates 
risks for  employees and clients. It may result in a sudden risk to life, property, 
health, etc.

  Accident: The occurrence of unplanned and uncontrolled events resulting in 
personal injury is defined as an accident.

 Ans 7. Emergency: An emergency at the workplace is an event that occurs and creates 
risks for  employees and clients. It may result in a sudden risk to life, property, 
health, etc.

Slips Trips Falls
Occur when there is too 
little friction or traction 
between the foot and the 
walking surface, leading 
to a loss of balance

It happens when the foot 
strikes or collides with an 
object, causing a loss of 
balance.

Result from a loss of 
balance,  causing the 
person to descend rapidly 
and freely from a higher 
to a lower level.

Common causes include 
wet or oily surfaces, loose 
rugs or mats, and weather 
hazards like ice or rain.

Often caused by poor 
lighting, uneven surfaces, 
uncovered cables, clutter, 
or obstructed views.

Can be due to slips or trips 
or from elevated positions 
like ladders, stairs or 
platforms.

Typically result in a 
backward fall.

Usually leads to a forward 
fall.

May result in injuries 
depending on the nature 
and height of the fall.

 Ans 8. The importance of cleanliness at workplace:
  (a) Neat and tidy environment reduces the risk of accidents such as slips, trips 

and falls.
  (b) Proper disposal of waste and flammable material can prevent fire hazards 

and pollution.
  (c) It improves efficiency and productivity of employees.
  (d) It can prevent equipment breakdowns and interruptions.
  (e) It reduces the spread of germs and illness, leading to healthy workers and 

less instances of falling sick.
  (f) It ensures a safe workplace.

 Ans 9. The steps to be followed by an organization while developing an evacuation policy 
are:

  (a) It clearly defines the roles of employees, managers and employees in 
implementing health and safety measures.

  (b) It ensures the workplace complies with all relevant health and safety laws, 
regulations, and industry standards.

  (c) It requires employees to assess risks, identify hazards, and implement control 
measures to minimize health and safety risks.

  (d) It specifies the need for training and providing employees with information 
about health and safety practices, procedures and potential hazards.

  (e) It outlines clear procedures to follow in case of emergencies such as fires, 
accidents, or natural disasters.

  (f) It mandates regular monitoring and review of health and safety practices to 
ensure they remain effective and compliant with standards.

  (g) It establishes procedures for reporting accidents, near miss incidents, and 
hazards to maintain a safe work environment.
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 Ans 10. Evacuation routes and exits are established in these following ways:
  (a) Identify Hazards: Recognize potential emergencies such as fires, earthquakes, 

or chemical spills.
  (b) Designate Exits: Ensure at least two exits are available, located far apart 

to prevent both from being blocked simultaneously.
  (c) Create Clear Pathways: Maintain unobstructed, well-lit routes leading to 

exits.
  (d) Use Proper Signage: Place visible and illuminated "EXIT" signs above doors 

leading out.
  (e) Conduct Drills: Regularly practice evacuation procedures to familiarize 

everyone with the routes.
  (f) Assist Special Needs: Plan assistance for individuals with disabilities during 

evacuations.
  (g) Review and Update: Periodically check and update evacuation plans to 

accommodate changes in the environment or personnel.

 Ans 11. Two basic fire safety rules to be followed in any organization are:
  (a) Ensure a clear passageway to all escape routes.
  (b) Outline escape pathways that are short and lead directly to exit doors.


